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The first step is always the hardest.

We are here to break that rule and make it the easiest.

This eBook is written for new users of the free E-Commerce platform OpenCart, which is an
open-source project. The eBook will show you how to start from scratch with the platform
and how to build your way up to a fully running online store.

The beginning of the eBook is about the installation process of OpenCart. Then, we will
move on to clearing the demonstration data from the standard installation. The rest of the
eBook will be all about explaining each of the menus in your Administration panel, how they
work and what they are used for.




Chapter 1: How to Install OpenCart

In the first chapter of this eBook, you will learn how to complete the installation of OpenCart
from scratch.

Before we begin, these are the server requirements you need to run a smooth OpenCart
installation:

e Web Server (Apache suggested)
PHP 5.3+(1.5.x at least 5.2+)
e Database (MySQLi suggested)

Download OpenCart

To begin the installation, you need to download the files from the official website of
OpencCart.

Sign Up Login Users Online Contact

o e n‘ O r f Boocorme & memdec of Acoss your sooount Currecy 2058 users cnine Neod some help?,
L Opanlarnt kir free

Downlond

Faster, responsive & easier to use!

>
Download OpenCart 2.2

Or you can sl got OpenCart 1.5.6 hon

At the time of writing this (May 2016), the latest version of the platform is 2.2.0.0. You will
notice that you can choose to download some of the previous versions of OpenCart.


http://www.opencart.com/

Easy set-up by our hosting partner

A2 HOSTING

OUR SPEED, YOUR SUCCESS

Click here to get started now

« OpenCart automatically setup for you
« Hosting fully optimized for OpenCart websites
« 24/7/365 technical support

Download & host your own

OR

« Download OpenCart for free

DOWNLOADNOW &

» Customise your own hosting solution

« Install and configure your store

OpenCart franslations can be downloaded from the extension store or the Crowdin OpenCart page.

Downloads Changelog
Version Release Date Action
2.2.0.0 (Latest version) March 2, 2016 [ Download ]
21.02 January 12, 2016 [ Download ]
21.01 October 6, 2015 [ Download ]
You will download the ZIP file. Unzip it and open the folder.
900 [ 2.2.0.0-compiled
< 11 E(m o1 B v L+ 2 Q, Search
Favoritos Name ~  Date Modified Size  Kind
%3 Dropbox ¥ buildxmi Dec 27, 2015, 7:16 PM 2KB XML File
15} isenselabs —W
) W cHANGELOG AUTO.MG Jan 11, 2016, 10:45 AM 331KB  Markdown
@) AirDrop W changeiog.md Mar 2, 2016, 10:45 AM 32KB  Markdown
A Applications composer.json Jan 28, 2016, 7:19 PM 415bytes  JSON
Desktop >
B Documants . composer.lock Mar 2, 2016, 10:47 AM 24KB  Document
u
© Downloads install.tx Jan 28, 2016, 7:19 PM 4KB  Plain Text
Devices license.txt Dec 27, 2015, 7:16 PM 35KB  Plain Text
£ isenseLabs... =
B reAOME.md Dec 31, 2015, 11:24 AM S5KB  Markdown
3 g tests Mar 2, 2016, 10:46 AM 95KB  Folder
Tags upgrade.ixt Dec 27, 2015, 7:16 PM 6 KB Plain Text
Red '
o » B uplosd Mar 2, 2016, 10:46 AM 29MB  Folder
© Orange =
Yeliow » B vendor Mar 2, 2016, 10:47 AM 55MB  Foider




From all the files you will see, the most important one is the upload folder. It contains all the
important files that are used to upload OpenCart to a web server.

By now, you should have an established web server and hosting. We have a post on the
server requirements needed to run an OpenCart store without a hitch - you can view it here.

Setting Up Your FTP Client

We suggest using FileZilla. It's one of the most popular FTP (Flle Transfer Protocol) Clients
used to transfer files to web servers. You can use it to upload your OpenCart files to the
server you have established. You can download the FileZilla client from here:

Download
FileZilla Client

All platforms

Important Note: Some web servers do not have FTP support. If that is your case, use an
alternative method to upload files (SSH, Online web hosting file manager, etc).

After you install FileZilla on your computer, open the application and find the folder you
unzipped with the OpenCart files.


https://isenselabs.com/posts/what-server-do-you-need-to-run-opencart

00 FileZilla
4 A0 et &ke BDIAT0
Host: | | Username: Password: Port:

Local site: [Usersfisenselabs/Downloads/2.2.0.0-compiled/upload/

T w RPPICITeNS

» 4 Desktop
» . Documents
¥ i Downrloads
¥ ¥ 2.2.0.0-compiled
> tests
> '
Fllename A Filesize Flletype Figname A
» .
» admin Directory
» catalog Directory
» image Directory
» install Directory
 system Directory
.htaccess.txt 2363 txt-file
config-dist.php 0 PHP
index.php 389 PHP
php.ini 451 ini-file
4 files and § directorics. Total size: 3203 bytes Not connected,

ServerjLocal file Oirection Remote file

Queued files Failed transfers ~ Successful transfers

Fllosize Fllotype

Not connected to any server

Size Priority  Status

@ Queve: empty

Last modified

Input the details of the account you have configured after setting up your server and hosting.

Input your Host (the URL of your host), Username and Password. Click Quickconnect.



4 oel wfl CEETE S
Host: Username: Password: Port: Quickconnect | =
Status:
Status:
Status:
Status:
Status:
Status:
Status:
Local site: /Usersfisenselabs/Downloads/2.2.0.0-compi ¥ Remote site: / v
TN ARSI >
» . Deskrop
» i Documents . A
Y W Downlosds Find the unzipped hle] _
v W 2200-compled [Root dlrectory]
> W tests
Fllename A Fllesize F Flename A Fllesize Fletypeo Last modified Permissions  Owrer)Group
¥ admin D public_htm! Directory  05/17/16 13... 0750 2102 99
w catalog D
» image D
» install D
w system D,
htaccess.txt 2363
config-dist.php oM™
index.php 389 P
php.ini 451 in
4 files and § dvectorios, Total size: 3203 bytes 7 fles and 11 Srectorios, Total sizo: 40799 dytes
Serverflocal flo Direction Remote file Sizo Priocity  Status
Queued files = Falled transfers ~ Successful transfers
iy ¢ W@ Queve: empty e

After you have logged in and connected to your host, you will see the root directory on the
right - in our example, it’s called public_html. This is the folder where your OpenCart shop
will be located.

Important Note: Not everyone is installing OpenCart in their root, this is just our example.

Uploading OpenCart

The location of your store’s website varies based on whether you want the store to be seen
on the main page, a sub-folder, a subdomain, etc. If you want to make OpenCart the main
page, you will need to upload files to the root folder of the website.

Open the public_html folder and create a new directory for your OpenCart installation. For
example, our directory will be called /public_html/OpenCart22Test.



Filename Filesize Filetype Last modified Permissions Owner/Group

P OpenCart22Test Directory

Selected 1 directory.

Find the unzipped folder in the Local site field with the OpenCart files and open them. Click
on the upload folder.

These are the files you need to upload to your server.

Select all of the files, right click and then click Upload.

Filename Filesize

P catalog 4 Upload

P image ¥ Addliles to queue
P install o
en
P system Eait
2363

Create directory 0
Create directory and enter it 389
Refresh 451
Delete

Selected 3 dire

This action may take a few minutes to complete. Be patient.

After the upload is finished, there are two files that you need to manually modify. You have
to rename the config-dist.php file in the root directory as well as the one in the admin folder.

Simply delete the -dist part so the file’s name is config.php.



Filename A Filesize Filetype

.. controller Directory

. language Directory

.. model Directory

. view Directory
config.php 0 PHP
index.php 369 PHP
php.ini 406 ini-file

Rename config

Last modified

05/17/16 14...
05/17/16 14...
05/17/16 14...
05/17/16 14...
05/17/16 14...
05/17/16 14...
05/17/16 14...

Permissions

0755
0755
0755
0755
0644
0644
0644

to config.php

Owner/Group

2102 2097
2102 2097
2102 2097
2102 2097
2102 2097
2102 2097
2102 2097

Creating Your Database

You are almost finished. The next thing to do is create the database for your OpenCart
store. To do that, you need to access the control panel of your site (cPanel for example).

The control panel is where your MySQL Databases are managed.

(Not all web hosts have support for cPanel. In these cases, you should contact
your web hosting provider and ask them to set up a new database (or give the
credentials to their existing database is one exists.)

Important Note: The details for your control panel must be delivered by your hosting

provider.

Access the databases and create a new database with a new name by entering a username
and password. By doing that, you create a user that has to be added to the database. While
adding your user to the new database, it's important to make sure that you add all of the

existing permissions.

10




e
Password

Protect
Directories

G

Subdomain

12

MySsaL

MySQL
Databases

CGI Center

PHP Manager
oy
SuperHosting

Security

3 8 & W

IP Address SSL/TLS HotLink Leech Protect
Deny Manager Protection
Manager
Domains
Addon Parked Redirects Simple DNS
Domains Domains Zone Editor
Databases
L R -
P {4\ SN
Myt B min My 500
MySQL phpMyAdmin Remote
Database MySQL
Wizard
Software and Services
7 =
E @ B @
CloudFlare PHP PEAR Optimize Softaculous
Packages Website Apps Installer

Advanced
DNS Zone
Editor

m

Memcached
Manager by
SuperHosting

In the field New Database, input the name you wish for your new database. We will name
our new database the same way we named our directory in FileZilla - opencart22test.

Create a New Database

New Database: =

_opencart22test

Create Database l

4 Jump to MySQL Users

Add your user to the database you just created. In our example, the user’s name is octest.
When you are ready, click Add.

11




Add a User to a Database

Add

User: | _octest §

Database: _opencart22test s

This will take you to the privileges (permissions) screen. Select all the privileges and confirm

them by clicking Make Changes.

v ALTER / v

¥ CREATE v
¥ CREATE TEMPORARY TABLES v
¥ DELETE v
¥ EVENT v
¥ INDEX v
¥ LOCK TABLES v
¥ SELECT v
¥ TRIGGER v

o

Make Changes

«# ALL PRIVILEGES

ALTER ROUTINE

CREATE ROUTINE

CREATE VIEW

DROP

EXECUTE

INSERT

REFERENCES

SHOW VIEW

UPDATE

Your database is ready! You can now install your OpenCart.

Install OpenCart to a Website

Installing OpenCart from here on is very easy. Open a browser of your choice and write the

following in the URL field:

yourdomain.com/TheExactFolderName/install

In our case, the name of our folder is OpenCart22Test, so our URL looks like that:

ourdomain.com/OpenCart22Test/install

12




Hit enter and this screen should appear.

1 /4 License agreement opencort 7

Please read the OpenCart licence agreement

0 License
GNU GENERAL PUBLIC LICENSE =
Version 3, 20 June 2007 Prednstallation
Copyright © 2007 Free Software Foundation, Ing, <hatpu//fsf.org/> Configuration

Everyone is permitted to copy and distribute werbatim copies of this icense document, but changing & is not allowed.

Preamble LANGUAGE ~
The GNU General Public License is a free, copyle®t license for software and other kinds of works.
The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By

E— o

Project Homepage | Docurnentation | Support Forums

Click Continue.

Make sure that all of the listed files and folders are writable. After that, simply follow the
steps and make sure everything is enabled.

3 /4 Configuration opencart 7

Enter your database and administration details

1. Piease enter your database connection details.

Likense
b o e | The user you created in your Control Panel (cPanel) )
* Hostname calhost / Configuration
* Username
LANGUAGE v
e (The database name )
« Database ’ S
“port 3306
Prefix  oc.

2. Please enter 3 username and password for the administration

* Username
Create the username and
EPaeword password for your store
*-Maill

= =3

13



When you get to the Configuration step, input the username and password you created for
the database in your Control Panel (cPanel).

Next, input the name of the database you created.
The other fields do not have to be modified.
Finally, configure the credentials you will use for logging into your OpenCatrt store.

Click Continue.

A4 Installation complete Opencart 7

Ready to start selfing! \

| © Don't forget to delete your installation directoryt |

- e

GO YO YOUR ONLINE SHOP LOGIN TO YOUR ADMINISTRATION

Congratulations!
Your brand new OpenCart store has been installed!

You can now view the front end of your online shop, or login to the administration and begin
learning the settings.

But before that, do not forget to delete your installation directory from FileZilla for security
purposes.

To do that, go back to the FileZilla application and delete the install folder from the files you
uploaded to the remote server (the right side).

14




Filename A Filesize Filetype

» ..

. admin Directory
. catalog Directory
. image Directory

CEEETN  § oownioad

W system 4 Add files to queue
L -htaccess.txt Enter directory
| | config.php iew/Edit
index.php ;
= a5 Create directory
| | php.ini

Create directory and enter it
Create new file
Refresh

Rename
Copy URL(s) to clipboard
File permissions...

' Selected 1 directory.

e |

Size

Last modified

05/17/16 14
05/17/16 14
05/17/16 14

05/17/16 14... 0755

05/17/16 14
05/17/16 14
05/17/16 14
05/17/16 14
05/17/16 14

=

Permissions  Owner/Group

... 0755 2102 2097
... 0755 2102 2097
.. 0755 2102 2097
2102 2097

... 0755 2102 2097
.. 0644 2102 2097
.. 0644 2102 2097
.. 0644 2102 2097
.. 0644 2102 2097

Your store is ready and you can start selling!

opencart 7

Desktops Laptops & Notebooks Components Tablets Software

Phones & POAs Cameras

MP3 Players

¥ 0 em(s) - $0.00

15




Chapter 2: How to Remove the Demo Data in
OpenCart
If you have paid attention to chapter 1 of our eBook, you would now have a freshly installed

version of OpenCart. This means you are ready to start building your store and filling it with
your products, images, attributes and so on.

However, as you see, the default installation of OpenCart contains demo data with examples
of products, logos, etc. They are there to show you how the basic functions of the platform
work and to test the settings.

16



opencart > - :

Deskiops Laptops & Notebooks Components Tobdets Software Phones & POAs Camneras M3 Ployers

Featured

MacBook iPhone Apple Cinema 30" Canon EOS 5D
ntel Core 2 Duo processor Powered by Phone 15 2 revolutionary new mobile The 30-nch Apple Gnema HD Display Caron's press materiad for the £OS SO
an lonel Core 2 Dud processor at phone that alows you 10 make a call delvers an amazing 2560 x 1600 pleel wanes that it 'defnes (3) new DSLR
speedsup o 2.1 By Simply Lappang 2 nam resobion, Designed 5p canegoey’, while wo'r
$602.00 $12320 $110.00 #0040 $93.00 a0
Ex Taw $500.00 x Tax $101.00 Ex Tac $50.00 £x T $80.0

T ADD TO CART v e ™ ADD TO CARY v b ¥ ADD TO CART v = ™ ADD TO CART v =

Canon

ey  (atyly — e

So, to start building your store, you need to erase all of the demo data and examples that
are currently there.

How to do that? It's probably one of the simplest things you can do in OpenCart.

Deleting Categories

Go to your admin panel and access the Categories.

Catalog > Categories

17



Categories

M Category List

v Category Name v

v Cameras

v Componercs

Lort Order

+
«Q

il
7/

BR

Next to the Category Name, you will see a box. Check it and it will select all of the existing

categories. Click on the trash icon to delete the categories.

Deleting Products

Next, it's time to delete the demo products (iPhone, iMac, etc).

Catalog > Products

John Doe Products

Ademievntratod

@& Dashboard

Product List
© Gtalog
e Product Name Price
> Products
Maodel Quantity

/l-u;e Product Name v Model

Status

Price Quantity Status

Deleting Attributes & Attribute Groups

Moving on, the attributes are the next section to delete.

Catalog > Attributes > Attributes

= V Ust

/" Ratribute Name v Attribute Growp

v S S 1201020 Omiplay

v Cotapeed Processor

v wnl Memory

Sort Order

SENEN:

=
(o]




Do the same for the Attribute Groups

Catalog > Attributes > Attribute Groups

Attribute Groups . ssuces BB

I8 Aunrigite Group List

¥ Attribute Groop Nama v Sort Order Action
v Dagiyy
v Méencey n
v Mathecboard '
,
‘s

Deleting Manufacturers

Next, you have to delete all of the manufacturers that are below the demo products.

Catalog > Manufacturers

Manufacturers [+ i8]
W Manufagurer List /
/(.M(nuu Name v Sort Order Action
v agple
‘o
& | sofy

Deleting Banners

The banners are the big images in the slider at the home page of your default OpenCart
store. Here is how to delete them.

Design > Banners

19



Banners .. swes
B Baglfer List

Banner Name v Status

V' Home Page Sideshow Erabied

Action
v WP Producs fradled

v Manufacturers Erabled

Poof! Now it’s all gone.

Here is how the front end of your store should look like now:

opencart > - |

Your store is all empty and ready for a fresh start.

In the next chapters, we will explain how each of the menus in your administration panel
work, and what to use them for.

20




Chapter 3: Dashboard

This tutorial is about a place where you will spend a lot of your time - the OpenCart
Dashboard.

We will walk you through each element you see so you know what all the metrics account for
and what the settings are used for.

Let’s start from the basic sections you see from the beginning.

% o >
Important Notifications (Orders, 8 .0 Vesie
Customers, Products, Affiiates) t

View Your Store's Front End

® World Map W Sales Anatytics 0.
= .
= '
£ Recent Activity ® Latest Ovders
& P Order 10 Curtomer et Dote Abded Totar Aean
Order Statistics
aal* v 4 pre CY returs
D e brdianit Most Recent Orders

Show/Hide Admin Panel - You have an option to show or hide the admin panel menus in
order to save space and focus on the task at hand. The menus will still be accessible, just
minimized at the left side of the screen. This setting works both in desktop and tablet mode.

Order Statistics - Below the admin panel, you have three bars showing important statistics
about your orders. They are Orders Completed, Orders Processing, Other Statuses.

Notifications - At the top right, you see a Bell icon. These are the notifications you have for

important things such as orders, customers, products, and affiliates. We will explain a bit
more about them later.

21



Your Store - The circle icon allows you to view the front end of your store and also access
the home page of OpenCart’s website, as well as the official OpenCart Documentation.

Latest Orders - At the bottom, you will see a tab with your most recent orders. It shows the
Order ID, Customer name, Order Status, the Date it was added as well as the Order Total.

John Doe Dashboard i resssise

Adminstrator

Dashboard TOTAL ORDERS

p Catalog . . 0

- Extensions

3 Design 'V, Admin Panel Menus P&
" Sales ']
Customers

Marketing

World Map

System

Reports

Administration Panel Navigation - All the functionality that OpenCart offers can be
accessed from here. The admin panel is where you find all of the settings and adjustments
you can make to your website. This is where you add categories and products, install
extensions, edit orders, modify your store’s design, launch marketing campaigns, and many
more.

® World Map

] Shortcuts to Fundamental Metrics and Settings oo
e ——— Woumomen
=]

2%

The 4 large boxes at the top are where you can quickly view your Total Orders, Total Sales,
Total Customers and all of the people that are currently online in your web store. All of the
boxes also work as links so you can access each of the sections in your admin panel.

22



@ World Map

v o

// ’

| The Countries that Generate Orders |

World Map - this is an interactive map that highlights the countries from which your
customers make their orders. The heavier the color, the more orders come from the country.
If you are running a store that has an international market, keep an eye on this to be aware
of the potential marketing and advertising opportunities you have.

Ll Sales Analytics 3
12 Today

Week
19| [Sales Analytics per Day, Week, Month, Year } — [ Month |

Year
= \
06

04

02 b

00
01 02 03 04 05 06 07 08 ©9 10 11 12 13 W 15 W% W7 1B 19 20 ¥ 2 23 24 5 W 27 B B W N

Sales Analytics - This field shows you the timeline of your sales filtered by day, week,
month or year. It's based on the number of orders and customers you currently have in your
store.
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Orders

— . Processing (0 ]
Important Notifications: Completed o
Returns [ 0 ]
Orders Customers
Customers Customers Online (0
Products Pending approval 0 |
Affl l IateS Products
Out of stock 2 ]
Ll Sales Analytics Reviews B
Affiliates
= Pending approval 0 ]

Notifications - As you see, you have a comprehensive list showing important data about
Orders, Customers, Products and Affiliates.

This field shows the number of orders that are processing, completed and the number of
returns you have.

You also see the number of customers online, and the customers that you need to approve.

The products that are out of stock are immediately shown, as are those who have received
reviews.

At the bottom, you will see the affiliates that need to be approved.

Stores ™=

Your Store

Your Store Front

Help &
Homepage

OpenCart Home Page
OpenCart Documentation
OpenCart Community Forum

Documentation

Support Forum

24




Your Store - This is where you can access the front end of your OpenCart store. Click on
Your Store to see how it looks.

25



Chapter 4. Catalog

To help you understand what OpenCart is, how does it work and what to do with it, we will
guide you through each menu and its submenus in the administration panel. We will start
with the first menu - Catalog. This is where you edit most of the content of your online store,
such as the product categories, products and information pages.

# Dashboard

® World Map L Sales Analytics &

Categories

Your product categories determine how organized your products will be. This is where you
will be spending quite a bit of time when you are setting up your store from scratch.

The categories are listed according to their Sort Order number that you can assign manually
so your list is more structured and easy to work with.

26



Jobo Dos Categories e
FENENS & | Create new product category ]/ u u

@& Dashboard

B Category List [ Edit an existing category )

% Catalog
Category Name v Sort Order Action
» Categories

Cameras 6

Companerss )

~

|

:

-
SNOENEED

Click on Add New to see the category creation fields. They will appear in three separate
tabs - General, Data and Design.

This is where you choose a name for your product category (e.g. Men’s Clothing, Computers
& Laptops). Underneath, you have a rich text editor for writing the category description. Give
some useful information about the products in the category and use that opportunity to
sprinkle some of those magic keywords around.

If you want your product categories to help with SEO (which they can), the category name
and description are the most important fields for that. Consider adding a couple of long-tail
keywords that will help with more specific user searches and smaller competition.

The Data tab allows you to do further improvements to your category such as adding an
image, filters, subcategories and separating them into rows or columns.

Category Columns

opencart 7

Desktops Laptops & Notebooks Components

&= Columns

Canon

PC(0)
Mac (1)

Show All Desktops

27


http://www.wordstream.com/long-tail-keywords
http://www.wordstream.com/long-tail-keywords

Category Rows

opencart 7

Desktops Laptops & Notebooks Components Tablets Sof

Macs (0] Windows (0)

Show All Laptops & Motebooks

In Design, you can override any layout you choose to the category you are creating or
editing. This lets you add modules to layouts that can be assigned to only one category,

instead of all of them.

To Learn More, Check the Ultimate Guide to Creating and Editing OpenCart
Categories

Catego ries Home / Categories /B o)
' Save changes '

# Add Category

General Data Design

[ Define the Category name and description )

[ 3 English /

* Category Name Category Name
Description v B I U x % & & OpmnSnsy A v = 5 Evy Tiv @B %S @ O =~
X @ ?
* Meta Tag Title
Products

Once you are done creating and modifying your categories, it’s time to start adding products
to them. This is the section where you create new products and modify their data.

28
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https://isenselabs.com/posts/how-to-create-new-opencart-categories-with-seo-in-mind

The products in your OpenCart store can be modified on many levels. You can filter and sort
products by name, price, model, quantity or status.

Jolin Doa’ Products . s - - B
ok et = Product List
WSS { Use the filters to find products easier } Copy a product
TN Product Name Price Seatus
> Products

odel Quantiey =3

Edit products data
Image Product Name v Mode! Price Quantity Status Action
- Apple Ceerna 30 Product 15 oo & £ Enobled
. Canon EOS 50 Product 3 SN0 B enobies

Clicking on the Add New button will lead you to the product creation fields where you will see
a lot of tabs and fields you can fill.

Don’t be overwhelmed by the level of customization you can do, it's not all necessary. Some
of the settings in the tabs called Recurring, Discount, Special, Reward Points or Design
are not mandatory, and you can use them only if you need them.

The fundamentals of product creation are in the General, Data, Attribute and Option tabs.

It's where you edit the product name, description, keywords, product images, as well as the
different options and attributes such as colors, sizes, types, etc.

29



Products e : srose

Wide range of product data editing options
& Add Product

Save changes

General Data Links Attribute Option Recurring Discount Special Image Reward Points Design
(3 English (Choose a product name and product description]

* Product Name Product Name

Description /v B I U X x S§~» Open Sans v A~ =2 E Ev Tiv M~ > @ o -

Qcnb i G | SEO boosting opportunities )

Meta Tag Meta Tag Description
Description

Meta Tag Keywords Meta Tag Keywords

Product Tags © Product Tags

Recurring Profiles

Depending on the type of business you are running, you will either use recurring profiles a
lot, or probably not at all. These profiles are used for customers who are subscribed for a
regular product or a service and they need to make recurring payments.

In order to automate these recurring payments for the subscription, you will use the
Recurring Profiles in OpenCart.

Click the Add New button to create a new recurring profile and see how the system works.

30



ReCUmng Profiles Recurriog Profies (Crea:e new recurnng proh!e]ﬁ 2 n

Dashbo
el @ Recurring Profile List

® Catalog Copy profile
Nomwe Sort Order
_o:ctc profile

The first thing you see is a blue notification giving some useful information about how the
recurring amounts are calculated - the payment frequency and cycle.

For example, if you use a weekly frequency and a cycle of 2, the recurring profile will be
billed every 2 weeks.

The price you set is the amount of each recurring payment, and the duration is the number

of times the payment will take place. If this is left at O, payments will be transferred until they
are cancelled manually.
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Recurring Profiles . s / -
© Recurring amounts are calculated by the frequency and cycles. ' Save changes '

For example if you use a frequency of "week” and a cycle of "2, then the user will be billed every 2 weeks.
The duration is the number of times the user will make a payment, set this to 0 If you want payments until they are cancelied,

# Add Recurring Profile

/ Profile Name

* Name = Name

Recurring Profile

/ { Price and duration for the recurring payments '

Price 0
Duration 0
/ { Cycle and frequency of the recurring payment
Cycle 1
Frequency Day :
Status Disabled :

Filters

The OpenCart filters are used to narrow down the results for users and refine their search so
products can be found faster.

To set these filters up, you need create them as separate modules and assign them to the
layouts in OpenCart.

Start by clicking Add New to view the filter creation field.
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Flters . . — Oo

I Filter List Filter list
Filter Group v Sm Action

M 0

CoenCant © 20092016 AR Rights Reserved
Version 2.1.01

First, you need to select a name for the Filter Group. This will be where the filters
themselves will be found. The individual filters are added with the Plus icon.

Like in our example, if your Filter Group is called RAM, the filters can be 4GB DDR4 RAM,
8GB DDR4 RAM, 16GB DDR3 RAM, etc. Another example for clothing stores can be a Filter
Group called Sizes and filters named XS, S, M, L, XL, XXL, etc.

To Learn More, Check the Ultimate Guide to The OpenCart Filter System

Filters Finers (save changes "V i

# Add Filter I(The name for the filter group]
* Filter Group Name [=d
Sort Order Sort Ord LStart adding new filters]
v o /[Fmer name, e.g. - 8 GB DDR4 RAM } S
e

This is an example of how filters can look in the front end of your OpenCart store.
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-~ Laptops & Notebooks
Refine Search
RAM
16 GB (1)
4GB(1)
8GB(Y)
Attributes

In OpenCart, attributes are part of the product description. Often, they are used for showing
technical specifications, dimensions and other important product details.

Begin adding a new attribute to see what you can do with it.

i ALtributes . e [+ |
@ Dashboard B Attribute List Add or edit altributes
% Catalog
Attribute Name v Attribute Group Sort Order

5° 195 192001080 Display 1

2
g

,
LLLLLLLL

As you see, below the name you need for the attribute, there is a field where you have to
select an Attribute Group.

Attributes are all sorts of product data such as dimensions, functionalities, requirements,
capabilities and much more. In our example, we have used the size and resolution of a
smartphone display - 5” IPS 1920x1080. This includes the display size, type of display and
the resolution. The attribute group for this type of attribute can be called Monitors, Displays,
etc.

34




ALtributes v  ase )ﬁ -
[ Save changes

£ MdAute { Attribute name )
* Attribi N : Attribute Name -
teribute Name £ /[AﬂflbUte QVOUP]
Attribute Group Display H
Sort Order

This is an example of how attributes look like in the front end of your OpenCart store.

Description Specification Reviews (0)

Display

5" IPS 1920x1080  The IPS display offers excellent colors and the resolution Is sharp enough to deliver a premium experience.

Attribute Groups

To combine the different attributes, you need Attribute Groups. These groups are used to
help you describe your products in more detail.

Create a new attribute group to see what you can do.
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& Auwribute Group List

Astribute Group Name Sort Order

Attribute Groups . wesces r/n
Add or ednananZps]

Desplay s
Memcey
Mothetboard

Processor 4

TTTLE

Showng 110 504 5(1 Pages)

&
B
-

As you see, it cannot be simpler - you just select a name that is simple and general enough
to fit multiple attributes. Give it a sort order number for better organization and begin adding
attributes for product specifications.

To Learn More, Check the Ultimate Guide to Attributes and Attribute Groups

Attribute Groups v :ssecos: (Save changes ) =>il

# Add Attribute Group /(Choose an attribute group name, e.g. Display, Memory)

* Attribute Group =
Name

Sort Order

Options

Product options give you the chance to offer different versions of the same product. An easy
example for clothing is colors - red, white or blue t-shirts.

Add a new option to see the type of options you can add in OpenCart.
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OPLiONS e o g B

# Dashboard W Option List (Add new or edit currcntophons]

® Catalog

Option Name v Sovrt Order

f".‘

i

-
z
Y N S\ Y N N Y 3
=

Below the option name you need to pick, you have a dropdown menu with a few types of
options you can add. For instance, if you choose Select, you will have options that will be
selected from a dropdown menu in the product page. If you choose Checkbox, you will have
options that can be checked and unchecked when viewing the product.

Choose the type of option you want to add and give it an appropriate name. Once you select

the type of option, you also have to add an option value. For example, if you choose Colors
as a new option, you need to add values - Red, White, Blue, etc.

37



To Learn More, Check the Ultimate Guide to Product Options in OpenCart

o-

Optlons Home / Options
# Add Option
* Option Name (=4 Option Name
Choose 2
Type ¥ Select )
Radio :
Checkbox
Image
Sort Order Input
Text
Textarea
* Option Value Name =~
File
Date
Date
Time
Aetinn vakio] Date & Time
— Mo 7T T
® °
- PR - |
@ o
Manufacturers

The manufacturers in OpenCart are very easy to manage.

assign them to products.

Add a new manufacturer to begin.

Once they are setup, you can
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ODODOwS Manufacturers - n

A

@ Dashboard B MsnolectoverList [ Add new or edit existing manufacturers }

© Catalog

Maaufacturer Name v $ort Order Action
> Categories

Aopie

Cancn

Hewiett-Pacard

LT

It's completely straightforward - the manufacturer has a name, you can assign it to multiple
stores if you have them, give it an SEO keyword for the SEO URLSs if they are enabled, and
finally an image with the manufacturer logo.

When this is all done, you can go back to the products, click on the Links tab of the product

you want to edit, and assign the manufacturer there. This way, if a customer clicks on the
name of the manufacturer, your store will show all of the products you have from that brand.
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Manufacturers o :weses /ﬂ -

# Add Manufacturer [ Name of the manufacturer] (Save changes l

—

* Manufacturer

Name
[ \
[ Assign to muitiple stores if you have them }
’ [Keyword for the SEO URLs]
SEO Keyword @ SEQ Keyword

Image e [Manufacturer logo imagg

Sort Order

Downloads
If you want to add downloadable files to your OpenCart store, this is where to do that.

Click on Add New to see what options you have.

Downloads / ﬂ

IE Download List “
( Add new downloadable file )

Download Name v Date Added

No resuks!

Showing 0 10 0 of 040 Pages)

OpenCart © 2000-2016 Al Righes Resened
Version 2101
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After you give a hame to the downloadable file, you have to upload the file. This is done from
the field below, named Filename. The file can either be uploaded from here or via FTP into
System > (Storage) > Download.

The Mask is used to give a different name to the uploaded file, so the link will not lead
directly to your downloadable files. This protects any files that you don’t want people to
download unless they have an account in your store for instance.

Downloads ..  swmes { save changesm ™

# Add Download -
/[Name of the downloadable file }
* Download Name £ DOWY § Nafr
{ Upload the tile]\

? [Give it a different name so people can't link directly to it]

Filename ©

Mask ©

Reviews

Product reviews can be submitted by customers from the pages of your products, or you can
add them manually from the admin panel.

Let’s begin adding a new review to see the options.

John Doe’ Reviews /Ilﬂ
# Dashboard

B Review List
[Add new product review manuany]
® Catalog
Product Status
[Fliter product rewews]
Author Date Added \
Product Auvthor Rating  Status Date Added ~ Action

NO reits!

Showirg 0 to 0 of 0 (0 Pages)

You have the same fields like you have in the front end of your store. Author name, the
review text, and a rating. The only difference is that you can choose the product you want to
leave a review for.
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Also, any product reviews left by customers will appear in the Reviews section in your admin
panel. This is where you can check what users say and think about your products and
decide whether you want to approve the comments or not.

Important Note: The reviews submitted by customers will be disabled by default and won’t
show up in your store front. To make them visible, you have to enable them. To enable a
review, go to Catalog > Reviews, select the review, click Edit and Enable it from the status.

Reviews [ save changesm =

# Add Review

[Name of the review author and reviewed product]

* Author A /

* Product @

* Text

(The review itself]

* Rating 22 O3:C6e.0s ‘—ﬁroduct rating (from 1 to 5) ]
pe—
Status Disabled

Information

This is where you configure all of the Information pages in your OpenCart store - About Us,
Delivery Information, Privacy Policy, and Terms & Conditions.

These are the predefined pages that come with the standard OpenCart installation, and you
can either delete them or keep them for further modification.

Let’s begin adding a new page.
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Johe Dow? Information — -_—______' B

i Dashuosrc I8 Information List [ Add new or edit existing information pages )

W Catalog

Information Title v Sort Order

3

lon

About Our Team

Delvery Informasion

Privacy Poicy 3

SEEN

Terms & Condaions 4

Showirg 1 to & of 4 {1 Pages)

e Cart © 2000-2016 A% Rights Reserved

Version 2.1.0.1

The title of the page determines how the link to it will be called as well. Choose a title and
description with SEO in mind because this is a great place to put keywords that are related
to your niche.

The rest of the tabs and options allow you to use meta tags and keywords, assign the page
to multiple stores if you have them, choose whether it will be in the footer or not, or assign
different layouts with modules to them.

Information .o  wemser /ﬂ -

# Add Information { Save changes )

General Data Design

) Engish { Information page details }

* Information Title

* Description g B I | R = % & & OpenSons v A v E [ K- Tiv @~ » 2 0 -

* Meta Tag Title

This is how the footer in OpenCart looks like. It's where the information pages are found in
the front end of your website.
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Information
About Our Team
ormas
Privacy Policy
Terms & Conditions

Powered By OpenCart
Your Store © 2016

Customer Service
Contact Us
Returns

Ste Map

My Account
My Account
Order History
Wish List

Newsletter
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Chapter 5: Extensions

This tutorial will explain the basics of the Extensions menu in your OpenCart admin panel.
This is where you make all of the modifications to the files of your Ecommerce store. This
includes module installation, configuration of payment and shipping methods, as well as
other third party services and extensions that connect to your website.

Jopee Dashboard

# Dashboard
® Catalog

#»  Extensions

® World Map Il Sales Analytics M-

£ Recent Activity ™ Latest Orders

To begin, click on Extensions > Extension Installer. This is the first menu of the Extensions
panel.

Extension Installer

This is where you will be spending quite some time when you begin experimenting with
different OpenCart modules.

Whenever you need to extend the functionality of your store, you will need to download a
module and install it using the Extension Installer.

Note: You can install modules via FTP as well, but the ocmod.zip file has to be installed
through the Extension Installer.

Installing a module is very simple.

Click the Upload button and find the ocmod.zip file of the extension you want to install.
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The progress of the installation will be shown in the Progress bar below. It will notify you if
there is any issue with the process or if the installation has been successful.

If the extension that you are installing needs to overwrite some of the core OpencCart files,
they will be shown in the list below the Progress bar.

Note: If you are adding an ocmod.zip file with a code tag that matches an existing ocmod's
code tag, the file won't overwrite the other one. It will reproduce an error. In such a case,
you'll have to delete the other ocmod and then upload the current one or alternatively
change the code tag.

If you have a problem with installing an extension, you can use the QuickFix module to
resolve the issue.

Once an issue occurs, use the Clear button to erase the temporary files and start over.

To Learn More, Check the Ultimate Guide to Installing and Uninstalling OpenCart
Modules

Extension Installer

S [Fmd the .zip of the extension you want to msla.l]

#- Extension Installer
@ Catalog b ‘
oy / Clear the data in the Progress

# Extensions * Upload File © m . G bar and Overwritten files field

> BExtension installer

Progress
&[Progrcss bar showing the results from uploading the cx!cnscon]

Files that will be
overwritten

Overwritten files field showing the details of all the
core files that are modified by the extension

Modifications

The modification system of OpenCart allows you to modify and extend the functionality of
your store without the need to directly edit the core system files.

In case your ocmod is not working, check this article - OCMOD Not Working?

You can enable or disable modifications from the Actions. After you are done editing the
modifications, you need to click Refresh to rebuild your modification cache. This goes both
for enabling, disabling or deleting modifications.
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Modifications ... weses (s 2] 0]

O Whenever you enable / disable or delete 3 MOMICAon you Need 1o ciKk the refresh button to rebulld your Modification tachel

B Modification List Refresh. Clear, Delete

The list of Modifications you can do
lE g to extend the OpenCart functionality

Link, Enable/Disable

Modification Name v Author Version Status Date Added

GftTeaver by Servelabs Serelabs 25 [nadied VIRA20G

iSearchCorporase AS-0n Senselads 312 Enadied Q02016 nn
Local copy OCVOD by Sercelabs Senselads 12 Enabied 180272006 n n
PersistontCart by Sendelads Sertelads 24 Drsadied 102010 n n
PreOrder by Senselads Serselads 29 Enadied 1200572016 n n
PreviousNextProdut by Senselabs Serdelaln 22 Disabled 13052016 n u

The Log in your Modifications shows which modifications have been applied, which have not
been applied, and which line has been modified.

Modifications v  wesrcsons nnﬂ

O Whenever you enable / disable or delete a modification you need to click the refresh button to rebulld your modification cache!

Modification List

A Iog with all the detailed changes made to the OpenCart files.

General Log

2016:06-28 17:02:07 - MOD: Modification Default
FILE: system/engine/action.php

REGEX: ~{require | include)_once)A\({[7)])+)=
LINE: 39

FILE: system/engine/loader.php

REGEX: ~(require] include)_once) AN+ )
LINE: 20

LINE: 59

LINE: 80

LINE: 99

FILE: systemAibrary/config.php

REGEX: ~{require|includeX_once]A{[N))+)~
LINE: 23

FILE: systemAibrary/language.php

REGEX: ~{require |include)_once)N\([A))+)~

AN A
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To Learn More, Check the Ultimate Guide to the OpenCart 2.x Modification System

Analytics

The standard OpenCart platform comes with a native Google Analytics extension that can
be installed and enabled for your store.

After you install Google Analytics, click Edit where you will be able to configure the service.

Analytics

H Analytics List

Status Action

ki :m,'bnstall and enable Google Analyhch

To acquire Google Analytics for your store, you first need to create an account and a
website profile. Once you are done with this, you will receive a Google Analytics code, which
you will need to paste in the field below.

That’s basically it. Enable the status and your OpenCart website is ready to start tracking
analytics.

GOoOgle ANAIYLICS o /s + Goopennsyss B -

# Edit Google Analytics

© Login to your Google Analytics account and after creating your website profile copy and paste the analytics code into this fleld

Sasgn npaytas cogle Analyiics Code . e | The Analytics code you receive after creating
your website profile in Google Analytics

o [Enable / Disable Google Analytics]

Status Disabled
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Captcha

Verifying that your visitors are real users and not bots is very important, especially for the
registration page. You have a two options with the native OpenCart installation - Basic
Captcha and Google reCAPTCHA.

Install the Captcha method you prefer and hit Edit to configure it.

John Doe Captcha

Ad=

@& Dashboard

B Captcha List

Capteha Name Status Actlon

Basx Capteha Drsabied

Google reCAPTOMA Doabled

(Click to Install and Enable )

OpenCart © 20052016 Al Rights Reserved

Version 2.0.0.1

To begin using the service, you will need to register your website again with the Google
reCAPTCHA page. There, you will find the site key and secret key that need to be pasted in
their respective fields.

Enable the status and your OpencCart store is Captcha protected.

Google reCAPTCHA v con « soogerecmrans B -

# Edit Google reCAPTCHA

O Go to Google reCAPTCHA page and register your website.

Site key Site key and Secret key you acquire after registering
your website in the Google reCAPTCHA page.
Secret key
Enable / Disable
Status Disabled
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Feeds

The Feeds extension allows you to customize the way your products are viewed and listed
by Google or other search engines. To begin using this feature, you have to compile a
product feed with items from your OpenCart store.

Feeds

IH Feed List

{Install and Enable }

Product Feed Name Status \ Action

Google Base, Google Sitemap and OpenBay Pro are the three native tools you can use for
your product feeds. Google Base requires the user to upload product information in product
feeds so that they can show up in Google's search engine.

There are specifications that Google has issued for the product feed. They can be viewed in
Google's support FAQ.
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GoOgle Base o i reess / coogese

# Edit Google Base

Import, Save

Google Category Category Action

No results!

Showing O to 0 of 0 (0 Pages)

"\

Data Feed Url Create a product feed that will show up in Google's Search Engine

/[Enable / Disable J

Google Category

Status Disabled

Anti-Fraud

There are three fraud prevention services you can use with the standard OpenCart
installation.

FraudLabs Pro screens credit card transactions for online fraud. They detect possible
fraudulent orders and help online merchants keep their profits high by preventing false
chargebacks and other malicious attempts.

Anti-Fraud IP allows you to create a list of potentially threatening IP addresses that your
store will detect when users enter the website.

MaxMind is the second third party service you can use to protect your OpenCart shop. They
track, collect, and analyze the information about every user in your store and send back a
risk report.
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Anti-Fraud

Dashboard
- ey} B Anti-Fraud List

W Catalog

AnthFraud Name Status Action
# Extensions

Anti-Fracd P Disabled °

o
&
MaxMing Ant-Fraud Duabled °
g < o

Third Party Anti-Fraud Service can
be installed and enabled to protect
your store from online fraud

2

4
’
7’

Modules
The Module List is where all of your extensions are found. This is where you select which
modules to install or uninstall, as well as edit and configure.

Core Modules: Account, Affiliate, Banners, Bestsellers, Carousel, Category, Featured,
Google Hangouts, HTML Content, Information, Latest, Slideshow, Specials, Store.

Some OpenCart extensions are used to create additional modules that you can assign to the
different layouts in your store. For instance, the Slideshow extension is used to create

different versions of your slideshow that are listed as separate modules in the Module List.

Third party modules can be installed to alter, extend and improve the functionality of your
OpenCart store.
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John Doe Modules

A

# Dashboard - .
O Ater you have irstalied and configured a module you can add 1 10 a layout here!

© Catalog

# Module List The Module List with all the extensions
you have installed in your OpenCart store

f Extensions

Module Name Action

e 3
Banner > Category u

Seuselers

Cacouss!

Payments

This is the list with all the payment methods you have available with the default OpenCart
system. You can install, enable and configure them to your preference so that your
customers have multiple options to submit payments.

If you want to install additional payment methods, you can do that by adding them as
extensions from the Extension Installer.

Payments
= Payment List [List of all the native available payment methods]

Payment Methed Status Sort Order Action
Login and Pay with Asnaron a0 Dsabied

Authorie Net (AM) AnthorizeNet Drisabled

Authoreine Net {SSVy Authorize.Net Csadled

Bank Transfer Dsabled

BluePay Mosted Form (‘/r BlucPay Dusabled

BroePay Redwect (Requires SS1) M ’U,I.,«.rPay Disadled

Chague / Money Order Dsabled

Cash On Delvery Erabied 5
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Shipping

The default shipping methods you have in OpenCart are listed here. Just like the payment
methods, you can install, enable and configure them however you want. It's better to have
multiple shipping methods so different customers can use the ones they prefer the most.

Adding new shipping methods is done by installing a new extension with the Extension
Installer.

n Doe i i
il Shipping
chk , i . 1 le i .

@ Dashboard R { List of all native available shipping methods }
S Catalog

Shipping Method Status Sort Order Action
A Extensions

Austraba Post Dusabied

Citylink Dradied

Fedex Drsadied

Flat Rae abied

3 o Daadied

Pos e led

Parceiforce 48 Daadied

F ) abled

Order Totals

The Order Totals are extensions that you can use for adding extra fees to the total sum of an
order in your store's shopping cart. Aside from fees, you can also add Coupons and Reward
Points if you have configured them prior to that. To form the final order total, the shipping
and payment method costs are also added to it.
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» Order Yotals

Order Totals

IE Order Total List

Order Totals

Coupan

Store Crean

GATeaser FOROC < 2.200
Handing Fee

Karna Fee

Low Order Fee

Reward Points

Shipping

Ay

List of the fees and additions to the Order
Totals in your store’s shopping cart

Status $ort Order
Enabled “
(rabled 7
Daadled
Daabled
Oaables
Oisabdled
Erabled 3
Enabled 3
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Chapter 6: Design

Layouts

The layouts system in OpenCart lets you choose whatever modules you want to add to each
layout or page in your website. Each layout consists of 4 positions (Content Top, Left, Right
and Bottom) and different modules can be assigned to those positions with a given sort
order number that will determine the order they are arranged in.

Layouts . wps B
7

i@ Layout List
Add/Edit

Layout Name v

& Customers

< Marketing Compare

© System

SN NNNDDNDEEE

We will edit the Home layout to see what are the options you have.

Each layout requires a layout name, the store the layout will be added to, and a route. The
route is the folder name that the layout files are included in.

When you have them set up, it's time to add some modules to the layout. Choose the

module you want to assign to the layout, give it a position and sort order number and click
save.
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Layouts .. wes -

# Edit Layout

/ Name

Defat : COTenSVhOme

=
(Foa) B
Module / Position / Sort Order

Carousel > Home Page H Content Top : 3

« Account H Concere Top
Banner
Banner > Banner 1
Baaner > Categecy
Carouse?
Carousel > Home Page
Categocy
Ajax Quick Checkaut by Dreamventicn
Alax Quick Checkout by Deeamvention fChoose module]

Featured
Foatured > Home Page
Fiter

| Seacch Cotporate 3.1.2

Banners

The banners in OpenCart are images you can use to link to other pages. These images can
be customized to catch the user’s eye and lead them to certain product pages to increase
conversions.

The banners menu in the admin panel lets you create new banners and modify their image
dimensions as well as their titles and links.

Banners .

IE Banner List

Banner Nama v Status

Connection Enabled
Home Page Shdethow frabled
NP Products [nobled
Manufacturers Enabled
Workstaton Enabled
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Let’s create a new banner that we will use for the slideshow in the front end. We will name it
Workstation and upload an image with a great looking workstation. The status is enabled
and we are ready to assign the banner.

S Banners — =

) Lgpizent # Edit Banner

® Catalog ; Banner name

#» Extensions > * Banner Name Workstaton

/[Enable/Disable Banner
Status Enabled
Title Uak image $ort Order
= Workstauon WWW BOMSIN COMMToute ‘QIJ':! 0 n

<  Macketing ’ \ \
5

Go to Extensions > Modules > Slideshow > Edit. After the banner is ready, we need to
create a module for it.

Give the module a hame and select the banner title you want to use. Set the dimensions and
enable the module.

# Edit Slideshow Module
/ Choose a module name
Module Name Workstation
/ Choose the banner
Banner Workstation
Width 1140
>[Set the dimensions
Height 300
/ Enable the module
Status Enabled

“

“

It will now appear under Extensions > Modules. This means it’s ready to be assigned to a
layout and become visible in the front end.
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SMSBump 2.5

Slideshow

Shideshow > Workstation

SmartBar

This is how our brand new slideshow image looks like in our demo OpenCart store.

opencart > - :

Desktops Laptops & Notebooks Components Tabiets Software Phones & PDAs Cameras MP3 Players

59



Chapter 7: Sales

As a store admin, one of sections that you'll be visiting a lot in the OpenCart admin panel is
the Sales.

= opencart”

Dashboard iome asiscar

System Administrator

ninistrator

TOTAL ORDERS TOTAL SALES

Dashboard

Q@ World Map

The Sales section is the 5th one in the default OpenCart admin menu and is situated after
Design and before Customers. The Sales section is the place where you manage your
orders, product returns and other sales-related features of your webstore.

The default Sales section has a total of five submenus and in the following tutorial we will go
through them.

Orders

The first submenu is the Orders one and it's the most important one in the section. From
here you can manage your orders: view, edit or delete theme, add new ones, print order
invoices, shipping lists, etc.

Order Listing Page
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Order List

Order ID Order Status Date Added
Order ID v Date Added =]
Customer Total Date Modified
Fistormer Total Date Modified =]
Order ID A Customer Status Total Date Added Date Modified Action

95  testtest Pending $106.00 | 20/07/2016 20/07/2016 n n
94 dfdfdjf idkjfidjfdmfi Pending $131.20 | 14/07/2016 14/07/2016 nn
93 | Igor Mintusov Pending $602.00 | 06/07/2016 06/07/2016 nn
92 | Daniel Parsons Pending $106.00 | 02/07/2016 02/07/2016 nu
91 | Igor Mintusov Pending $106.00 = 18/06/2016 18/06/2016 nn
90  kamlesh mourya Pending $106.00 | 18/06/2016 18/06/2016 nn
89  Martin Jonesqq Pending $131.20 | 14/06/2016 14/06/2016 nn
88  testtest Pending $131.20 | 14/06/2016 14/06/2016 nn

Order Listing

Once you open the Sales page, you will see a listing of all orders in your store. The listing
contains some information about each order such as:

e Order ID: The Order ID is the unigue number of each order in your webstore.
e Customer: The name of the customer that has made the order.

e Status: The order status. For more information, please check the Order Status
section below.

e Total: The total amount of the order.

e Date Added: The date on which the order was added.

e Date modified: The date on which the order was last modified.
e Actions: View the order, Edit the order and Delete the order.

All of these columns except for the Action one are clickable and the listing can be sorted by
them.
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Order Listing Filters

Additionally, there are filters at the top of the listing, which help you easily find the orders
that you are looking for:

Orders: wme o =
= Order List
Order ID Order Status Date Added
v =}
Customer Total Date Modified
test3 test3 p— P
\
Order ID A Customer Status Total Date Added Date Modified Action
28 Qtest3 test3 Pending $1,077.60 | 01/09/2015 01/09/2015
e Pending $ 9, 1/09/20
k ir ges

Additional Order Buttons

There are three more buttons at the top right of the page. The first two are inactive if none of
the orders are selected. If you select at least one order by clicking the checkbox in front of it,
the two buttons will become active.

The first button with the truck icon is used for printing shipping lists. Once you click on it, a
dispatch note will show up with the order information, which can be printed later on.
The second button with the printing machine icon is for invoices. Once you click on it, an

order invoice will be generated.

The third icon is for creating a new order. The view of the new order is similar to the edit
order page, but with the difference that all input fields are empty.

Now let’s see what happens once we click on the order View action button...

Order View Page

The Order View Page contains a detailed information about each order.
Since there are differences in the layout of the order view page in OpenCart 2.0.x and
OpenCart > 2.0.x, we’ll go through both of them.
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OpenCart 2.0.x

If you are using OpenCart 2.0.x you will see a page with a few tabs.

Order Details

The order details tab is where we see the general details of each order.

Orders \;H;\ a

Orders

Order Details Payment Details Products History

Most of the details are quite clear and descriptive so we won’t go through each of them.
What is important to note here is that OpenCart doesn’t automatically generate invoice
numbers and if you would like to generate one for a specific order, you’ll need to come to
this page and click on the green Generate button. Once you click on it, an order invoice
number will be generated and later on added to the invoice.
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[
Orders Orders

Orders

i

Orders

Order Details Payment Details Shipping Details Products History Order Details Payment Details Shipping Details Products History

Also, if the order has reward points, you can add them by clicking on the Add Reward Points
Button or remove them if you have already added them.

Pending Order Status:

Payment Details

The payment details tab contains information about the payment.

In this tab you can check what the billing address of the customer’s order, the payment
method, etc.

Shipping Details

The shipping details tab is pretty similar to the payment details one with the difference that
we can see the Shipping address here as well as the Shipping method.

Products

In the product tab we can see the product ordered together with the selected options,
product model, ordered quantity, prices and order totals.
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Orders o o B -

= Orders
Order Details Payment Details Shipping Details Products History
Product Model Quantity Unit Price Total
MacBook Product 16 36 $
product 1 $ (3
oduct3 1. 59800 98.00
Sub-Total

Flat Shipping Rate

History

Every time the order status is changed, it is saved in the order history, which can be seen in
the following tab.

= Orders
Order Details Payment Details Shipping Details Products History
Date Added Comment Status Customer Notified

No

Complete No

Add Order History
Order Status Complete

Notify Customer

Comment

4

© Add History

From here we can check when and how the order status was changed. Furthermore, we can
add order history. If we check the Notify Customer checkbox, the customer will receive an
email with the changed order and the added comments if any.

OpenCart > 2.0.x

If you are using OpenCart > 2.0.x, the order view page will be one page containing all of the
already mentioned sections, but with slightly different design.
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Oorders o

A~

®™ Order Details & Customer Details # Options
B cetecere Invoice INV-2013-007
B om0t B3 oefaurc Reward Points 200
B} coshon Delivery Affiliate $0.00
n Flat Shipping Rate
© Order (#36)
Payment Address Shipping Address
dsfdsf dfdsfs fdsfsd fsdfdsf
fsdfds fdsfdsf
dsfsd dfsdfsd
Culfa Syunik'
Azerbaijan Armenia
Product Model Quantity Unit Price Total
Nikon D Product 4 1 $98.00 $98.00
iMac Product 14 1 $122.00 $122.00
Apple Cinema 30
- Radio: Small
- Checkbox: Checkbox 1
- Checkbox: Checkbox 2
- Text: test
- Select: Red Product 15 2 $162.80 $325.60
- Textarea: wewg
- File: —.png
- Date: 2011-02-20
- Time: 22:25
- Date & Time: 2011-02-20 22:25
Sub-Total $448.00
Flat Shipping Rate $5.00
Eco Tax (-2.00) $10.00
VAT (20%) $90.60
Total $553.60
© Order History
History | Additional
Date Added Comment Status Customer Notified
21/07/2016 Pending No

Showing 1 to 1 of 1 (1 Pages)

Add Order History

Order Status Pending

Override @
Notify Customer

Comment

Here we can see a few new fields:
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Affiliate: In the options container we can see an affiliate field. If the order has generated any
affiliate profit, you can add it to the affiliate’s balance by pressing the plus icon.

Override: In the order history we have a new checkbox Override. If checked, you'll be able
to override the order’s status in case it has been blocked from status changing by an anti-
fraud extension.

Order Edit Page

It the order edit page, we can edit all of the details that we have already seen in the order
view page. The order edit page is divided in a couple of tabs, each of them enabling us to
modify different order details. It is important to note here that we cannot click on the tabs,
but we can move to the next or the previous one only by clicking on the “Continue” or “Back”
buttons respectively, located at the bottom of each tab.

The first tab would be Customer Details. Here we have all of the information about the
customer: name, email, phone, etc.

The second one would be Products. Here we can change the quantity of the ordered
products, add or delete product, etc.

In the third tab, the payment details tab, we can edit the payment details of the order.
The shipping details tab is pretty similar to the payment details one. Here we can edit the
shipping information.

In the last tab, the totals tab, we can see all of the ordered products in a listing, but here we
cannot edit them. In this tab we can edit the shipping method, the payment method, apply
coupons, vouchers, reward points, etc. Here, you can also change the status of the order.

Order Statuses

The default OpenCart comes with a couple of pre-defined order statuses. These are:

Canceled
Canceled reversal
Chargeback
Complete
Denied
Expired
Failed
Pending
Processed
Processing
Refunded
Reversed
Shipped
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e Voided

You can add custom order statuses as well once you go to System > Localisation > Order
Statuses. On this, however, you will learn more in our next tutorial that will go through the
System Section. For now it's enough to know that OpenCart has both pre-defined order
statuses and an option for adding custom ones.

You can set a default order status (in the default OC installation this would be ‘Pending’),
which will be the one used for new orders. It is also important to note that some payment
methods come with an option for setting an order status. This means that all orders that
have used this payment method will be set to the respective order status. For more
information you can check the Tutorial for the extension section > Payments.

Recurring Orders

The second submenu is recurring orders. In the recurring orders we can see all of the orders
of recurring profiles made in the store. We are already familiar with how the recurring profiles
work. Once they are ordered from the store front, they are displayed here.

Recurring Orders

= Recurring Order List

Recurring ID Order ID Payment Reference

Customer Status Date Added

Recurring ID Order ID Payment Reference Customer Status Date Added Action

The table is similar to the orders one with filters and ordering. Here, however, you don’t have
the option to delete or add new recurring orders.

View Recurring Order

The first button in the action column enables you to view the Recurring Order. Here you can
see the recurring order details: ID, Payment Reference, Recurring profile, Description,
Recurring Status and Payment method. You can also see basic details about the order in
which the recurring profile was bought and the product to which the recurring profile is
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assigned. Additionally, you can see a history of the transactions associated to this recurring
order.

Transactions

Cancel Recurring Payments

Date Added

A blue button saying Cancel Recurring Payments enables you to cancel the recurring
payment associated with this recurring order.

View Order

The other blue button under the action column enables you to view the order in which the
recurring order was made. The page that opens up is the order view page.

Returns

The third submenu of the Sales section is Returns. OpenCart enables your customers to ask
for a return of the products they have bought from you. Here you can manage these return
requests.

Once you open the tab you will see a listing of all product returns requests.
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opencart 77 A O Logous

Product Returns

Product Return List

Return ID Customer Model Date Added

Order ID Product Return Status Date Modified

®*
®
LY
(]
3
-
<
&

E

ReturnID A Order ID  Customer Product Model Status Date Added Date Modified Action

The listing is similar to the one of the orders table. Here, we have one more field, Order ID,
which shows for which order is the requested return. Similarly to the Sales page, we have
sorting and filtering. At the top of the page we have two buttons: we can add a new return
request, or delete an existing one.

Return Edit Page

Once we click on the edit button on a certain return page Return edit page has two tabs and
first we would see the general tab. It gives us information about the order and a reason for
return.

OpenCart comes with a few predefined return reasons. You can manage them by going to
System > Localisation > Returns > Return Reasons. Additionally, you can manage the return
statuses from to System > Localisation > Returns > Return Statuses and the return actions
from System > Localisation > Returns > Return Actions. For more information, you can
check the Returns section in the Sales tutorial.

In the History tab, similarly to the order history tab, you can change the Return status and
add comments. If you check the Notify Customer checkbox, an email will be sent to the

customer including the comments and the changed status. In the history listing, you can see
how and when the return has been modified.

Gift Vouchers

The fourth submenu in the Sales section is the Gift Vouchers.
The gift vouchers functionality in OpenCart enables your customer to buy gift vouchers and

send them to other customers. The given gift vouchers can be later on used in your store by
adding the code from the voucher. The voucher amount will be deducted from the order
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total. The gift vouchers are specific for the customer they are given to and they can be used

only one time.

Gift Voucher Listing

You can manage your gift vouchers once you go to Sales > Gift Vouchers > Gift
Vouchers. Here you see a listing of all of the existing gift vouchers ordered in a table.

Gift Vouchers

Gift Voucher List

Code

Date Added ~

Action

Here we see the code of the voucher, the name of the sender and the receiver, the voucher

amount, theme, status and date added. You can sort the tables from all of these fields.

The gift vouchers are editable by clicking on the Edit button next to each of them. From here
you can modify the information added by the sender of the voucher and check the history of

each voucher.

From the main listing page you can send the gift voucher to the recipient’s mail by selecting
the checkbox in front of it and clicking on the button with mail icon at the top right of the

page. Only then will the recipient receive its gift voucher.

You can also add new gift vouchers by clicking on the icon with the plus sign or delete

existing ones.

Gift Voucher Themes

OpenCart comes with three predefined gift voucher themes and you can manage them from

Sales > Gift Vouchers > Voucher themes.

If you wish to edit a voucher theme, you can click on the edit button and change the voucher
theme name and the image. You can add or delete voucher themes. The voucher theme

image will be sent in the email to the recipient.
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Congratulations, You have received a Gift Certificate worth $1.00
This Gift Certificate has been sent to you by isense isense

With a message saying

testing

To redeem this Gift Certificate. write down the redemption code which is yC3BIe9ilD
then click on the the link below and purchase the product you wish to use this gift
voucher on. You can enter the gift voucher code on the shopping cart page before
you click checkout.

Gift Voucher Purchase

Your customers can buy a gift voucher from your store by going to Extras > Gift Voucher. In
the default OpenCart theme, this is located in the footer.

Purchase a Gift Certificate

This gift certificate will be emailed to the recipient after your order has been paid for

* Recipient’'s Name
* Recipient’s esmail
* Your Name Isense isense

* Your e-mail test@Pisenselabs.com

* Gift Certificate ® Birthday
Theme
! Christmas
General
Message testing
Amount 1.00

| understond that gift certificates are non-refundable. v Contnue

The customer need to fill in all of the needed information and to agree that the gift vouchers
are non-refundable. The Gift Certificate themes are the ones predefined from the admin.
After pressing the Continue button, the gift voucher is added to the cart as a normal product.
The price is the amount of the gift voucher set by the customer.

PayPal
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The last submenu is PayPal. From here you can search all of the transactions made to your
PayPal account. It is important to note here that the PayPal search will work only if the
PayPal Express Checkout account is set.

Once you go to Sales > PayPal > Search a form will open. From here you can either search
for transactions by date or by giving specific transaction details.

= Search Transactions
Search by date

Start

Here you can select a starting and ending date and after clicking on the search icon all
PayPal transactions in this period will be displayed.

If you are looking for a specific transaction, you can use the more detailed search.

Transaction

Type All

Email (Buyer)

Email (Receiver)

Receipt ID

Transaction ID

Invoice number

Auction item number

Amount

Recurring Profile ID

Or if you are looking for a specific buyer, you can use the fields in the Buyer information
section.
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Buyer information

Salutation ‘ Salutation
First ‘ First
Middle ‘ Middle
Last Last
Suffix ‘ Suffix
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Chapter 8: Customers

This tutorial will shed light on how to manage the customers that visit your store, separate
them by groups and create custom fields to require non-default OpenCart customer
information (e.g. Birthday date).

First, we will take a look at the place you will use to manage your customers.

JORDoS; Dashboard .

Ot 20ard

Dashboard

TOTAL CUSTOMERS

-
=2

® World Map M Sales Analytics

Ordors
W Cusoers

o0
QIO0I0OA A0LOT CRFI0 1 IO NI RAISO A TERIS 2001 22 IR 26T 2R 30D

Customers

This is how an example of the customers table looks like.
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Customers o —vﬂll

Dashboard .
B Customer List

r Catalog

Extensions
Customer Name Customer Group Approved Date Added

< Design L : : =]

r Sales
Ml Status »
: : Login as customer

Customer Name v (M0 Customer Group Status 2 Date Adde

Edit

© System Defau

M Reports el Enadied 210672016 .:,:_:f.l

It is pretty straightforward when it comes to its columns. You have the customer’s name, e-
mail, customer group (which we will discuss in a bit), status (Enabled or Disabled), IP and
the date of registration/addition.

The last column is by the name of ‘Action’ and has 4 buttons in it. The green one is for
approving the customer (if customer approval is set in the store). By default, the account of a
new customer will not work until you approve it from this admin panel menu. The second
(light blue) one is used for logging into your own store as the particular customer. The third
(orange) one is to unlock users that have locked their accounts by too many (a number set
from System > Settings. Check the chapter on that) unsuccessful login attempts. The last
(blue) action is probably the one you will use the most. It allows you to edit the respective
customer’s information.

Up above the table, there is a filtering form, which can be used for finding particular
customer/s.

There are two buttons on the very top of the page. An ‘Add New’ button, which you can use
to add a customer by manually filling all of their details and a ‘Delete’ button which can be
used to delete the customers, whose boxes are checked in the table.

Customer Groups
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Customer Groups S—— [+ Ji&

B Customer Group List

Customer Growp Name v Soet Order Action

Defauit (Defauit) 1

Showing 1101 of 1 (Y Pages)

DpenCant © 20092016 Al Rghes Rederved

The customer groups are a really useful OpenCart feature. It will allow you to separate the
customers of your website in groups and give them different privileges, set different product
prices for each, etc.

# Edit Customer Group

/[Group name
* Customer Group = Default
Name
Deseription / Group description
(s

&= | Approve new customers

Approve New Yes @ No
Customers ©

Sort Order 1

To create a customer group, click on the blue ‘Add New’ button on the top right. You will be
redirected to a simple form requiring you to choose a name, description and set whether
customers from this group will have to be approved by an administrator before they are able
to login. The ‘Sort Order’ field is to help adjust the order in which customer groups are listed
in the table. Deletion of customer groups happens the same way deletion of customers
does.

Custom Fields
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John Doe Custom Fields . cuomren ?n

Dashboard

@ Custom Field List Add/Edit
Catalog
Custom Fiald Name v Location Type $ort Order A«,
Extensions

—— p——

Showing 1ot of 1 {1 Pages)

Customers

w0Cart ©2000-2016 Al Rghts Reserved.
Version 2.1.01

The custom fields in OpenCart allow you to create additional customer information fields,
which may concern the customer’s account (birthdate, company name, etc.) or address
(specify a block, entrance, etc.) data.

To create a new custom field, repeat the drill of clicking on the ‘Add New’ button on the top
right. The form which you will be redirected to looks like this:

# Edit Custom Field
* Custom Fleid ol Birthday

Name

Location ALcoumt v

Type Date
Value )
Customer Group v Default

Required v’ Default

Status Enabled :
Sort Order © 0

The first field is for choosing the custom field’s label (e.g. Date of Birth).

The second field is a dropdown determining the location of the field. You would choose
‘Address’ if you would like the field to be for information relevant to the customer’s address
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and ‘Account’ for anything else. Needless to say, from the customer’s point of view, the field
will be located respective to the location you choose.

The third field is the type. It may be anything from a select (dropdown menu) to a file.

The fourth field is for chosing the customer groups you would like to use the custom field for.
All the customer groups in your store are listed here. Check the ones you wish the field to

apply for.

The next field allows you to make the field required. Thus, obliging your customers to
provide the information the field will be for.

The sixth field is nothing more than an on/off switch. Choose between ‘Enabled’ and
‘Disabled’ to toggle it.

The ‘Sort Order’ field is to adjust the exact position the custom field will have. You can enter
values with minus to count backwards from the last field in the default set.

If you have chosen ‘Select’, ‘Radio’ or ‘Checkbox’ for the field’s type, you should have a
table beneath all options. There, you will list the field’s values. To add a row, use the blue ‘+
button. Add as many values as you wish and give them names and sort order (optional).

If you have chosen any of the others, you will have 2 additional fields between the ‘Type’
and ‘Customer Groups’ fields. The first one is to set a default value for the custom field and
the second one is to validate it. Validation can be done by using regular expressions and
requires some basic regex/development knowledge.
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Chapter 9: Marketing

One of the most fun admin panel menus is Marketing. We will show you what you can do
with the native OpenCart functionality for creating marketing campaigns and running various
promotions to increase sales.

Let’s start by finding the main Marketing menu in your OpenCart admin.

Dashboard > Marketing

Dashboard

Al

Dashboard TOTAL ORDERS = -100%

M Sales Analytics M-

12

Marketing

The marketing menu lets you create, edit and track your marketing campaigns. You can filter
them by name, date or tracking code.

Click on Add New to create a new marketing campaign for your store.

After you are done, it will appear in this field.
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W Marketing Tracking List

Campaign Name

Tracking Code

Campaign Neme

Example Campaign

Marketing Tracking

Cede

ST8SSATIENY

/ﬂﬂ

| Add New Campaign

Date Added

| Track Clicks & Orders )
I | Edit Campaign I

=

Showing 10 1 of 1(1 Pages)

Clicks Orders Date Added

0 0 9012016

New Marketing Campaign

The campaign creation field is not complicated at all. All you need to do is add a campaign

name and description.

The tracking code is used to track all the activity generated from your campaign.

This code is put at the end of the link that leads to your website.

Marketing Tracking .

# Add Marketing Tracking
* Campaign Name
Campaign

Description

* Tracking Code @ 578368095105

Examples ©

Marketng Tratking

/Aracking~578368e951b5

/index.php?routescommon/homeltracking=578368e951b5

Affiliates

The affiliate system in OpenCart lets you add affiliate accounts for people you want to help
you generate more sales and traffic. Each affiliate has their own tracking code, just like the

marketing campaigns.
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This tracking code is used to track the traffic that the affiliate has lead to your website.

The Affiliates field lets you filter affiliates by name, status, date, email and whether the

affiliate has been approved.

Affiliates

B Affiliate List

Affilate Name Status

Customers

&  Marketing

Affillate Name v M

ANEe Jack exdrieGerasndiemad com

£Mail Appeoved

[Add New Anmate]——*ﬂﬂ

Date Added

=]

Edit Affiliate

Balance - Status Date Added ¥
1001 () Pages)

$9.00 Enadied 150772016

[Approve Afﬁhate] Showing 110

New Affiliate

This is the menu for creating a new affiliate account manually.

It's similar to the one for creating a new customer - you have to fill out personal information
and address, but there are some additions that make things a bit different.

Tracking Code - this is how the referrals that your affiliates generate will be tracked.
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# Add Affiliate

Affiliate Details

* First Name

* Last Name

* E-Mall

* Telephone

Fax

* Tracking Code ©

Password

Confirm

Status

Affiliates ...

$ Affilates

General Payment Details

ast Name

Fax

5781377204524 /

Affiliate Personal Information

Unigue Affiliate Tracking Code

Enabled G=——n l Affiliate Status '

The second part of the affiliate creation field is where the business details (Company and
website) are added, accompanied by physical address.
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Affiliate Address

Company

&= Business Details and Address

Web Site Web Site /

* Address 1

Address 2

* City
Postcode
* Country - Please Select —
* Region / State — None —

Payment Details
This is the second tab of the affiliate creation menu, where the important stuff happens.

Commission (%) - This is the amount that the affiliate will receive for each purchase made
from their link. It's up to you to determine how much of the total will go to the affiliate.

Tax ID - Tax ldentification Number.
Payment Method - Choose the payment method that you will use to pay your affiliates.

Cheque Payee Name - The name of the cheque recipient.

84



Affiliates o / amistes -

& Add Affiliate

General Payment Detalils

&= | COMmMission Percentage %)

Commission (%) © 5
TaxiD
Payment Method ® Cheque p How the payment is made
PayPal
Bank Transfer
R &=== | The person who receives the cheque
Name
Coupons

Coupons are used to assign discounts and run promotions for your OpenCart products. The
Coupons field is where all of them are listed. You can create new ones and edit them here.

Let’s create a new coupon and see the options.

Coupons {Add New Coupon]—’-n
il Coupon List
Coupon Name Code Discount Date Stary Date tnd Statys Action

Wiid Discount Coupon 665 250000 OvOI2014 210772006 Enabled

Showing 0t 0f1 () P.-,;rx
Edit Coupon

DpenCart © 2009-2016 Al Rights Reserved
Version 2.1 0.1

New Coupon

After you choose a hame for the coupon, you need to give it a unique code that will be used
to activate the discount.

Type - You can select the type of discount to be either percentage or fixed amount.
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Discount - The amount of the discount is input in the Discount field.

Total Amount - Input the total amount that must be reached for the coupon to be valid.

Customer Login - Set whether the customer needs to be logged in to use the coupon.

Free Shipping - Enable or disable free shipping.

Products - Add the products that the discount will be enabled for.

Coupons .

# Add Coupon

General

* Coupon Name

* Code @

Type @

Discount

Total Amount ©

Customer Login @

Free Shipping

Products ©

Percentage

Yes ® No

Yes ® No

B -

Define the Coupon Name and Discount Code

e

&= | Type of Discount

G

Discount Amount

=

Total

&= | Mandatory Customer Lo@

==

Free Shipping]

~

Assign the Products You Want Discounted

Category - You can assign entire categories that the discount will be enabled for.

Date Start / End - Set a time period for the validity of the coupon.

Uses Per Coupon - Set the number of uses the coupon should be limited to.
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Uses Per Customer - Set the number of uses the customer should be limited to.

Status - Enable or disable the coupon.

Category ©
\ Assign Categories You Want Discounted
S il el ¢ Time Availability of the Coupon
e y %
Date End 2016-08-20 (1]
UsesPerCoupon® | 1 & Times to Use the Coupon
P €= | Number of Customers to Use the Coupon
Customer ©
e i $==m| Status of the Coupon

Mail

The mail menu is used to contact your customers and send them your marketing campaigns
and messages.

You can use the field to create a mass email to multiple recipients:

To - All Newsletter Subscribers, All Customers, Customer Group, Customers, All Affiliates,
Affiliates

Subject - The title of your mass mail.

Message - write the message you want to send to your recipients using the rich text editor.
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John Doe Mail
Dashboard
\ ) DOBIC Na.‘l
Cataiog
Extensions > From Defaunt

8 0 = X

T

-0 -

| Send a Mass Marketing Email )

To N1 Newsletzer Subicnbers “ [Choose ReClplenlSJ ¢
- Subject == | Subject and Message )
* Message Z B I U ¥ x5 & #F HiwtdNewes A » B & Ry Tie S- I
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Chapter 10: System

You will see a default store, which is called Your Store. Click on the Edit button to modify
the current store, or delete it and create a new store from the Add New button above.

Settings
SKOres - s CTPTTITTD L
Dashboard & Store Uist
e ]
Store Name $tore URL At

Extensions

Yoo S0 (Defanlt) 7
- Design .

Sales
Customers Edit current store
penCart © 2009201 Rghts Reserved

e  Marketing

Systemn

> Settngs

Users

General

The first tab of the settings is relatively simple. These are just the basics:

e Meta Title - Add your store name so it appears in the browser tabs of your
customers when they open your website.

e Meta Tag Description - Every result that comes up in the Google search has a
snippet with a short description. This is the field where you can enter this description
- remember that the ideal length is about 160 characters.

e Meta Tag Keywords - This field is not mandatory as the Google algorithm no longer
adds the value of meta tag keywords to the search results. However, you can just

add a few keywords that are related to your industry.

e Theme - If you download and install a theme for your OpenCart website, you can
choose which theme to activate from this setting.

e Default Layout - Select a layout that will remain as a default one.
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General Store Local Option Image FTP Mail Server

The name of your store,
PR Sr— ‘—’ appearing in the browser tab
s | Gy | The description of your store
* appearing in the Google snippet

s Tas Harwerds G | Lis! the keywords associated with your niche )

‘/[Choose your theme )
Theme Defauit Store Theme

opencort | [ =]

P i - . I‘[Themeprevuew]

{ Choose your layout }

Default Layout Defauit ‘

Store

e Store Name - Type the name of your store.

e Store Owner - Type your personal name.

e Address - Input the physical address of your store.

e Geocode - Type the geocode of the area where your store is located.
e E-Mail - Input your admin email address.

e Telephone - Type your phone number.
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e [ax - Fax.

General Store Local Option Image FTP Mau Server

/' Name of your store '

* Store Name Your Store
/ Name of the store owner )
* Store Owner Your Name
/(Physical address }
* Address Address 1
/. The Geocode of your store '
Geocode @ Geocode
" Store owner email address '
* E-Mall
/l Your Ehone number '
* Telephone 123456789

Fax

Fax Fax

e Image - Upload the store logo image you want to appear on your Contact Us page.
e Opening Times - List the opening hours of your online store.

e Comment - Add any comments or important notes you want to leave for customers.
For example, “Store does not accept checks.”

Image 4 Choose your store’s image |
® @
'l List the times your store is open '

Opening Times © Opening Times

Add any notes or important subjects
your customers should know
Comment © Comment
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Local

e Country - Choose the country where your store is located.

e Region / State - Choose your region or state.

e Language - Choose the main language for your OpenCart store.

e Administration Language - Choose the language for your administration panel.

e Currency - Select the main currency you want to use for transactions in your store.

e Auto Update Currency - Enable or disable to update the conversion rate between

currencies each day.

e Length Class - The metric unit for length class.

Weight Class - The metric unit for weight class.

General Store

Country

Region / State

Language

Administration
Language

Currency ©

Auto Update
Currency ©

Length Class

Weight Class

Local

United Kingdom

Greater London

English

English

US Dollar

® Yes No

Centimeter

Kilogram

Option

Image FTP Mail

Server
/[Choose your country }
/[Select your region or state]
/l Select your store’s language '

o Select your preferred currency )

e (Enable or disable auto updatinc_; of currench

&
e

Metric unit for length and weight class '

o

-

-
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Option

Product and Category Options

e Category Product Count - Enabling this option will display how many items are
available in each product category.

e Default Items Per Page (Admin) - Define the item count for how many products will
be displayed in the admin panel.

Review Options

e Allow Reviews - Product reviews can be enabled or disabled from this setting.
Choose whether you want your customers to be able to submit reviews for your

products.

e Allow Guest Reviews - If product reviews are allowed, you can adjust this additional
setting for reviews from guest users who do not have an account in your store.

e New Review Alert Mail - Select whether you want to receive a notification email
whenever a new product review is submitted in your store.

General Store

Products

Category Product
Count ©@

* Default Items Per
Page (Admin) ©

Reviews

Allow Reviews ©

Allow Guest
Reviews ©

New Review Alert
Mzl ©

® yes

20

® ves

Option Image FTP Mall Server

Show the product count in the categories or not
No /[ P 2 ]

\[Number of products to show per pa@

Allow customers to post reviews
= ’ [ p )

No <y | Allow users without accounts to post reviews

* no g | Receive an email when a new review is posted }

Voucher Options
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e Voucher Min - The minimum amount a customer can purchase a voucher for. This
number will be calculated in the default currency.

e Voucher Max - The maximum amount a customer can purchase a voucher for. This
number will be calculated in the default currency.

Taxes Options

e Display Prices With Tax - Enable or disable the taxes to be displayed with the
product prices.

e Use Store Tax Address - The tax calculation will use the store's shipping or
payment address if the customer is not logged into their account.

e Use Customer Tax Address - The tax calculation will use the customer's shipping
or payment address if they are logged into their account.

Vouchers

*Voucher Min @

*Voucher Max ©

Taxes

Display Prices With
Tax

Use Store Tax
Address ©

Use Customer Tax
Address ©

1000 ‘

® Yes N

Shipping Address

Shipping Address

'\ Minimum and maximum amount a
customer can purchase a voucher for

P [Display tax along with prices or not]

== [Which address should OpenCart use to calculate tax]

Which address should OpenCart use to
‘/ calculate tax when a customer logs in

Account Options

e Customers Online - Choose whether you want OpenCart to perform customer
tracking and show how many customers are online.

e Customer Group - Set the default customer group that users will join when they sign

up.

e Customer Groups - Give new customers a choice to join specific customer groups
when they make their registration.
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Login Display Prices - Choose whether you want to show prices to users who are
not logged in.

Max Login Attempts - Set the limit for maximum login attempts.

Account Terms - Select the page to which new users will be forced to agree before
they are allowed to create an account.

New Account Alert Mail - Select whether you want to receive an email notification
whenever a new account is created.

Account
= (Enable or disable customer tracking)
Customers Yes ©® No
Online @
‘_ASet the default customer group]
Customer Group © Default

Customer Groups ®@ v/ Default G [Let users choose which customer group to join upon signup)

Logln Display ves ® no [Only show prices when users are Iogged in]

Prices @
’ (Set the login attempt Iimit]

Max Login 5
Attempts @
’(Forces people to agree to your Privacy Policy]
Account Terms @ Privacy Policy
N A 3 e o o - [Recenve an email when a new customer signs up '
Ml @

Checkout Options

e Invoice Prefix - Set the invoice prefix. Invoice IDs will start at 1 for each unique

prefix.

e Display Weight on Cart Page - Choose whether you want to show the cart weight
on the View Cart page.

e Guest Checkout - Enable or disable checkout for guests who want to complete
orders without having an account in your store.

e Checkout Terms - Choose the page which you want customers to agree to before
they are allowed to complete a purchase.
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Order Status - Choose the default order status that will be enabled after an order is
confirmed by the customer.

Processing Order Status - Define the status that will enable product subtraction,
coupon, voucher or reward point redemption.

Complete Order Status - Choose the default status for a completed order.

Fraud Status - Set the status that will appear when an order is suspended due to
suspicious activity.

New Order Alert Mail - Choose whether you want to receive a notification email on
your admin email address whenever a new order is confirmed.

API User - Since version 2, OpenCart has an API for integration with third party
services. The same API is also used by OpenCart when editing orders for example.
In order to access the API, a pair of username and API key is used. These pairs are
created from System > Users > API. This option lets you select which pair will
OpencCart use, when it uses the API.
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Checkout

Invoice Prefix @

Display Welght on
Cart Page ©

Guest Checkout ©

Checkout Terms @

Order Status ©

Processing Order
Status @

/ | Set the invoice prefix '

INV-2013-00
® Yes No
® Yes No

Terms & Conditions

Pending

Show the cart weight or not '

&

"l Enable or disable guest checkout )

Forces users to agree to Terms & Conditions]

l Set the default order status when an order is submitted '

-
-

When will an order begin stock subtraction, -
SHRa === | oupon, voucher and reward point redemption

Canceled Reversal

Chargeback
'/Complete
Denied
When will customers be able to get
‘/ downloadable products and gift vouchers
c°"""‘;;?u":°°' Canceled '
Canceled Reversal
Chargeback
v Complete
Denled
/' Set the default order status for fraudulent orders )
Fraud Status © Canceled :
New Order Alert i @Ohe ‘—[Receive an email when a new order is submitted )
Mail @
&~ |The API user the admin should use '
APl User @ Default
Stock Options

e Display Stock - Choose whether you want to display stock levels in product pages.

e Show Out of Stock Warning - Enable or disable the warning notification if a product
is out of stock.

e Stock Checkout - Allow or deny checking out with products that are out of stock.
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Affiliate Options

e Affiliate Requires Approval - Enable or disable automatic affiliate approval.

e Automatic Commission - Enable or disable automatic commission reward.

o Affiliate Commission (%) - Configure the commission percentage for affiliates.

e Affiliate Terms - Choose the page that you want all new affiliates to agree to before
they complete their registration.

e New Affiliate Alert Mail - Choose whether you want to receive a notification on your
admin email whenever a new affiliate completes their registration.

Stock

Display Stock @

Show Out Of Stock
Warning @

Stock Checkout @

Affiliates

Affillate Requires
Approval @

Automatic
Commission @

Affillate
Commission (%) @

Affiliate Terms @

New Affillate Alert
Mall @

Yes

Yes

‘—[Enable or disable stock in product pages '

® No

Enable or disable Out of Stock warning

°no G ossage on shopping cart page

G Enable or disable checkout when

Yeg M0 a product is out of stock
/ [Automatically approve affiliates]
Yes ® No
.’ [Automatically add commission]
Yes ® No
" [Set the affiliate commission percentaﬁ]
5
/ l Force affiliates to agree to terms and conditions '
About Us

Yes

< p [Receive an email when a new affiliate signs up |
No

Return Options

e Return Terms - Select the Terms page that you want customers to agree to when
submitting a product return.

e Return Status - Select the default status of an order when it's submitted for a return.
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Captcha Options

e Captcha - Enable Captcha verification. They are configured from Extensions >
Captcha.

e Captcha Page - Check the pages you want the Captcha verification to be enabled
for.

Returns
Return Terms @ = NONe =+ _ [Select the = e and status]
Return Status @ Awaiting Products
Captcha
Captcha © e NONE wos

@==m [ Enable Captcha and select the pages to request it}

Captcha Page
Register

Guest Checkout
v Reviews
v'Returns

v Contact

Image

e Store Logo - Upload your store logo.

e Icon - Upload your store icon which will be shown in the browser tab. The
requirements for the icon are PNG 16px by 16px.

General Store Local Option Image FTP Mail Server
Store Logo @’ wpload your store logg)
opencart 7
e 7,1-" " (Upload an icon (Dimensions: PNG 16px by 16px) J

| B
-
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FTP

All of the fields here should be filled with the FTP details you have from your hosting
provider.

e FTP Host

e FTP Port

e FTP Username

e FTP Password

e FTP Root - Input the directory of the installation of your OpenCart store.

Enable FTP - Enable or disable FTP.

General Store Local Option Image FTP Mail Server

FTP Host

FTP Port = LEnter the FTP details from your hosting provider ]

FTP Username

FTP Password

&= | The directory of your OpenCart installation (public_html) }

FTP Root ©

SRR i @ 4__[Enable or disable FTP )

Mail

e Mail Protocol - Choose your mail protocol between Mail or SMTP.

e Mail Parameters - If you select “Mail” for the protocol, you will have to enter an email
address.

e SMTP Hosthame - If you are using SMTP, input the address of the SMTP host.

e SMTP Username - Enter the full email address of the SMTP host.
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e SMTP Password - Choose your password.
e SMTP Port - The SMTP port number is provided by your SMTP host.
e SMTP Timeout - The timeout is also provided by your SMTP host.

e Additional Alert E-Mails - Input any additional email addresses you want to use for
receiving notifications.

General Store Local Option Image FTP Mail Server

Mall Protocol © Mail “(Ma" or SMTP]

L= Additional Mail parameters

Mail Parameters © Mail Parameters

o { Add a prefix if a security connection is required )

SMTP Hostname @

SMTP Username

\(. Type your SMTP username and password )

SMTP Password ©
SMTP Port

SMTP Timeout

Additional Alert E-
Mails @

/(Additional email addresses for receiving notifications]

Server
General Options

e Maintenance Mode - Enable or disable your website’s maintenance mode. This will
make your OpenCart unreachable for all customers.

e Use SEO URLs - Choose whether you want to use SEO URLs. These URLs use the
SEO Keywords you can select from the different page settings in OpenCart.

e Robots - A list of web crawlers that will be prevented from using shared sessions in
your store.
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Output Compression Level - GZIP for more efficient transfers to requesting clients.
The number sets the level of HTTP compression used in your HTTP headers.

General Store Local Option image FTP Mail Server

General

" [Enable or disable Maintenance mode]

Maintenance Yes ® No
Mode ©
&= | Enable or disable SEO URLs }
Use SEO URLs © Yes ® No
Robots @ abot List the web crawler agents that
goax / won't use shared sessions
€00
hbot
kbot
/ (Output compression from 0 to 9]
Output 0

Compression

Level ©

Security Options

Use SSL - Enable or disable SSL certificate.

Allow Forgotten Password - Choose whether you want to allow using the forgotten
password option for the admin login.

Use Shared Sessions - Select whether you prefer using session sharing with
multiple OpenCart stores and shopping carts if you have any.

Encryption Key - This is a secret combination that is used to encrypt private
information. Use both letters and numbers for better protection.

Upload Options

Max File Size - Define the max file size you want to be uploaded in your store. The
number should be in bytes.

Allowed File Extensions - Input all of the file extensions you want to be allowed in
your website. For example - TXT, PNG, MP3, PDF, etc.

Allowed File Mime Types - Input all of the file mime types you want to be allowed in
your website. For example - Image/GIF, Application/ZIP, Text/Plain, etc.
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Security

Use SSL @

Allow Forgotten
Password ©

Use Shared
Sessions ©

Encryption Key ©

Uploads
Max File Size ©
Allowed File

Extensions ©

Allowed File Mime
Types ©

PR { Enable or disable SSL )

Yes ® No

ey, lAlIow forgotten password to be used for admin

o G l Enable or disable session sharing '
Yes No

€= | Secret combination to encrypt private information

/ { Max file size in bytes }
300000 :

/ { Select which file extensions can be uploaded }

ip

pe
ioeg

/ | Select which file mimes can be uploaded )

text/plain
image/png
image/jpeg
image/glf
image/omp

L o Ao M

Error Handling Options

e Display Errors - Enable or disable error displaying when a problem occurs.

e Log Errors - Choose whether you want to keep a log of all the errors that have
occurred in your store.

e Error Log Filename - Choose the filename where the log will be kept.
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Error Handling

/ [Enable or disable displayed errors J

Display Errors ® yes No

logErrors  ®'ves  'No = { Enable or disable error IOM
== {Name of the log filename l

* Error Log error.log
Filename

Users

The Users menus allow you to manage all of your users and user groups. You also have
access to the API settings of your E-Commerce store. You can manually create new ones,
edit existing ones or delete them. User groups are designed to give or take viewing and
modifying permissions to specific users.

Users

Going to the Users menu, you see a list of users with enabled or disabled status as well as
when the user was added. Let’s edit a user and see the fields that need filling.

Users - v

@ UserlList

Username v Status Date Added

L Ll Enabied &2ms
cemo Enabled 3032016

Erample fratied 29032016

Showing 110 30f 3(1 Pages)

enCart © 20092016 Al Rghts Reserved
Verson 2,109

For our example, we chose to edit the admin user. As you see, the fields are relatively
straightforward - personal information, email address, password.

The interesting part is that you can select a User Group. This helps with the sorting of users
and assigning permissions to each group.
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& Edit User

* Username

User Group

* First Name

* Last Name

E-Mall

Image

* Password

* Confirm

Status

admin
Administrator

john

savav@isenselabs.com

ey

Enabled

"' Username |

P Email Address

= User Image |

‘_-‘ Password
&===|Enable / Disable

User Groups

Here, you can see two predefined User Groups - Administrator and Demonstration. We have
created a third one - Users. These user groups are what allows you to set the permissions
for viewing and modifying between your users.
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User Groups . - susue Ba

B User Group Add/Edit

User Growp Name v

Once you click edit, you see all of the admin panel menus that can be accessed and
modified. Select the ticks on whichever menu you want to allow or deny for your users.

If you decide that one of your user groups should not have maodifying permissions, simply
remove the ticks from the categories and click save.

For example, analytics/google_analytics refers to the Analytics section in the Category menu
of your OpenCart Dashboard. The same goes for all the rest - they are the Admin panel
pages of your online store and you can decide which group has the rights to view or modify
each of the pages.
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# Edit User Group

* User Group Name Agdministrator

Access Permission
v analytics/google_analytics

v captcha/basic_captcha
v captcha/google_captcha
v catalog/attribute

/(a:a?ogjattrnbuze_group

N

Select All / Unselect Al

Add & Remove Access and Modifying Permissions

Modify Permission
v analytics/googie_analytics

v captcha/basic_captcha
v capteha/googie_captcha
v catalog/attribute

¥ catalog/attribute_group

Select All / Unselect All

The API of your store allows it to co

nnect and integrate with third party services and

applications. Using the API requires you to create a new pair of credentials. Click on Edit on
the Default APl name to see how it’s done.

APIs

E APILst

AFIName v

Default

Fﬂ
=

{1 Pages)

Staten Date Added

Enadled 180272016

Shawingitot ol

PpenCar ©2009-2016 All ghts Reterved

Viersion 2.1.01

General

First, you select an API Name.
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Second, you generate an API Key.

Third, you enable its status and your API credentials are ready!

APIS wora rao

# EditAPI

* AP Name Defast

&= | Choose an AP| Name }

B | Generate an API Key )

Status Enadied

~

| Enable / Disable API }

IP Addresses

This field lets you enter the specific IP addresses that can use the API. The system
automatically detects your current IP.

# Edit API

General 1P Addresses Session

© Below you can create a list of IP’s allowed 1o access the APL. Your current IP is

Add New |P |cam=)

Session

In the Session field, you can track the usage of the API. You can see what Token was used,

which IP address used it and what date and time it was last used.
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# Edit API

The Last IP address and Date

e ‘Manwe pS0Y the API Credentials were Used
Token P Date Added Date Modified Action
Localisation

The Localisation sub-menu contains a lot of fields for logistical properties that need to be
setup for smooth order, payment, shipping and returns management.

Store Locations

The first field is Store Locations - it allows you to list all of the physical addresses your store
might have. Click on add new or edit the existing one to view the details.

Store Locations ... sweismes [ + [
B Store Location List -
Add/Edit

Store Name Address Auv
Store Namne Addeess
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The information fields are fairly standard - store name and address, phone, fax, opening &

closing times. You can add an endless number of physical stores and their addresses.

# Edit Store Location

* Store Name

* Address

Geocode ©

* Telephone

Fax

Image

Opening Times @

Comment ©

Store Name

Address

Geocode

Teiephone

Fax

—

Opening Times

Comment

Languages

Manage your store’s languages from here. Stores with multiple languages are easier to use

on an international level. Click Edit or Add New to see the settings.
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JehnDos Languages

Adeieiatrasnoe
Dashboard

B Language List
b Catalog

Language Name v Code Sort Order
Extensions

Design Ergiah (Defauit) en

Sales Showing 110 1 of 1 (! Pages)
Customers

S  Marketing

System

Language Name: Input the name of the language you want to add.
Code: Language name has their own code (en for English, de for German, etc).

Locale: The Locale is the language code that browsers use to auto-detect the language of
the website. They can be found here.

Image: You need to add the image name for the language you are creating (national flag).
Directory: The directory is the location of the language pack.
Status: Enable or disable the language from the store front.

Sort Order: Set the number that will arrange the position of the language among the others.
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# Edit Language

* Language Name English

*Code © en

*Locale @ en_US.UTF8.en_US.en-gb.english

*image @ gbpng

* Directory @ english

Status @ Enabled .

Sort Order 1

Currencies

OpencCart allows you to constantly keep an eye on the currency values. You can use the
refresh button and check how the currencies are going at any moment.

Clicking add or edit will show you the currency editing field where you can setup the details
for the currencies you want to use for the transactions in your E-Commerce store.

Currencies

IH Currency List

Currency Title v

US Collar (Defauit)

| Refresh Currency Valuesbn

Code Vaur
fUR 0.50770000
oap Q75860000 200

uso 1.00000000

DpenCart © 20092016 All Rghts Reserved

Vergon 2.1.09

Last Updated m,
2012016

N0

Showing 110 3 0f 3 (1 Pages)

112




Currency Title: The name of the currency.

Code: The ISO code for the currency you want to add, check all of them in this list.
Symbol Left: Adds the currency symbol to the left of the code.

Symbol Right: Adds the currency symbol to the right of the code.

Decimal Places: The amount of decimal places displayed in the price of the front end of
your site.

Value: The Default currency is set to a value of 1. Every value of currency will be relative to
this value. Since the US Dollar is 1.0 (the default), the Euro is tabulated to .81 for the value
based on its worth. This is the value that OpenCart will use to calculate the prices in the
store front. Your currency values will be automatically updated if you enable Auto Update
Currency in the store settings.

Status: Enables or disables the currency in the front end of the store.

# Edit Currency

* Currency Title Euro

*Code ® EUR

Symbol Left

Symbol Right €

Decimal Places 2

Value @ 0.90770000

Status Enabled

Stock Statuses

These are the statuses that show the availability of your products in the front end:
2-3 Days - It will be available soon.

In Stock - The item can be ordered.
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Out of Stock - The item is not available.

Pre-Order - The item is only available for preorder and will be delivered when available.

Stock Statuses

IE Stock Status List

Stock Status Name v

2-3 09y
n Stock

Cut Of S

Q
8

Pre-Order

To edit a stock status, simply change its name.

# Edit Stock Status

* Stock Status Name [ In Stock

Order Statuses

The field for order statuses lets you manage the many possible statuses an order can have
after it is confirmed by customers. The native options in OpenCart cover a wide range of
potential order statuses.
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Order Statuses ... e s n

i@ Order Status List Add/Edit

Order Status Name v

Dashboard
Catalog
Extensions
Canceied
Canceled Reversal
Customers

Chargeback

s Marketing

€& System

Pending (Default)

Processed

Processing

9
2
LT E

Refunded

After you are done editing the order status, you can select it under Sales > Orders > View >
Add Order History.

& Edit Order Status

* Order Status = Complete
Name

Return Statuses

Just like the order statuses, the return statuses notify customers of the condition of their
return request. The standard options in OpenCart are just three - Awaiting Products,
Complete and Pending.

115



Return Statuses

g
Bl

IE Return Status List -
Add/Edit

Return Status Name v

‘
t
‘3
:
BN B«

Showng 1o 301 3(1 Page

Return Actions

Once a customer submits a return, the store owner must take action. After you take the
decision, you can either issue credit, give a refund or send a replacement. These are the
three native options in OpenCart, however you can create additional actions.

© System

Return Action Name v MJ

Credn oued ’

Return Actions T

» Setvrgs

IH Return Action List

Replacement Sent

owing 1 1o 3o () Pages)

nCart © 2009-2016 All Rghts Retecved

Return Reasons

When customers submit returns, they must select a reason for that. There are 5 options with
the standard OpenCart installation - Dead on Arrival, Faulty, Order Error, Received Wrong
Item, Other.

All of these actions, reasons and statuses are assigned from Sales > Returns > Edit
Return.
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Return Reasons .. -suwnsess Ba

E Return Reason List

Add/Edit

Return Reason Name v

Acth
Dead On Arrrval
Faulty, pleate supply decads
Order Error
Ocher, please suppdy detals
Recerved Wrong Rem

Showeg 1o S 51 Pages)

Opendant © 2000-2016 AT Rghts Reserved

Maanass

Countries

The OpenCart admin panel holds 239 countries. They are used to estimate the shipping and
tax for each customer when they log in. You can disable and delete the countries you don’t
need, however once a country is deleted, enabling it again will require its creation from
scratch.

JonnDoa: Countries o  coue Ba

Dashboard

IE Country List :
b Catalog Add/Edit

Country Name v 50 Cedo () 150 Code (3)

Extensions

Design Axiang islands AX ALA
Sales Afghaniazan A5 AG
Customers

& Marieting

Npera oz DZA

System

AMencan SHmoa AS ASM

Andorra AD AND

Mgy A AA
Antarctca AQ ATA
Antigua and Barbods 7 ATG

Argenting AR ARG

N\

3

3

A
FIIHHI!!!!IH!

Armensa AV ARM

Anida AW AW
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Zones

Along with the 239 countries, OpenCart also has 3948 zones. These zones are the regions,
states or provinces of countries. They help with better calculation of shipping and taxes.

Zones

B Zone List

Country v

Urived States

Unsted States

Zone Name

Maine

Marshall idangds

Maryland

Massachusetts

Mhgan

Manesota

ML LIpN

Nebrawaa

Nevada

New Hasnmpihire

New jeriey

Zone Code

v

L]

\v

N

Add/Edit

2
FHH!HB!!!H!!H!Q

Geo Zones

Geo Zones are used for combining different zones into one Geo Zone so it becomes easier
to calculate shipping and taxes for multiple regions at once. The Geo Zones are configured
here and are used in Extensions > Shipping.
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Geo Zones

B GeoZone List

Geo Zone Name v Oescription
UK Spping UK Shipping Zoowes
UK VAT Zone UK VAT

enCart © 20002016 All Rghts Reserved,

?ﬂ

Actied

Showing 1102 0 2 (1 Pages)

Geo Zone Name: Select a name for the Geo Zone.

Description: Describe the Geo Zone and its regions.

Country & Zone: Select the country and zones the Geo Zone will include.

# Edit Geo Zone

* Geo Zone Name UK Shipping

* Description UK Shipping Zones

Country Zone

United Kingdom ; Al Zones

-

Tax Classes

This is where your store’s taxes are created and managed. You can apply these taxes to the

products in your Opencart store.
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Tax Classes

IH Tax Class List

Tax Class Title v

Dowrioadadle Products

Taxable Goods

DperCart © 20002016 Al Rights Reserved.

Verson 2.1 01

The platform comes with two native tax classes - downloadable products and taxable goods.
Create new ones, edit those or delete them according to your own preference.

Select a tax class, add a description about the products that it's applicable for and add
multiple tax rates by assigning different priorities.

# EditTax Class
* Tax Class Title Taxable Goods
* Description Taxed goods
Tax Rate Based On Priority
VAT (20%) v Shipping Address H 1 n
Eco Tax (-2.00) v Shipping Address v 2 n
Tax Rates

This menu lets you configure the tax rates and their value. You can create tax rates for
different regions and Geo Zones.
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Tax Rates

B Tax Rate Ust

Tax Name v TaxRate Type Geo Zone Date Added Date Modified

f
£co Tax¢-2.00) 20000  Fooed Amount UK VAT Zooe 2102011 23002011
1 Pages

VAT [20%) 200000 Percentage UK VAT Zone o201 2050201

Showirg 1t 2 of 2(1 Pages)

DpenCan © 20052016 All Rghts Reserved

Tax Name: A name for the tax class that will be displayed in the front end when taxes are
added to order total, for example - Eco Tax (-$x,Xx).

Tax Rate: How much the tax value will be.

Type: Choose whether the tax will be a percentage of the total or a fixed amount.

Customer Group: If you want the tax rate to be enabled only for a specific set of customers,
add them to a customer group and select it from this option. Multiple customer groups can

be selected.

Geo Zone: Select which Geo Zone you want to apply the tax for.

# Edit Tax Rate

P Config_;ure the Tax Name and Rate

* Tax Name Eco Tax(-2.00) /

* Tax Rate 2.0000

Type Fixed Amount ’ Tax Type

‘/ Customer Group to Receive the Tax

Customer Group v Default

Geo Zone UK VAT Zone / Geo Zone
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Length Classes

The length classes are used to assign length dimensions to the products in your OpenCart
store.

Length Classes

IH Length Class List

Length Title v Length Unit Value

Centmater (Oefavic) om 1 00000000

Showing 1 103 of 3 () Pages)

Length Title: The name of the metric unit, for example Centimeter.
Length Unit: The measurement unit, for example cm.

Value: The Default value must be set to 1. Every other length class will be relative to that
value. You can use this tool to measure the units.

# Edit Length Class

* Length Title x Inch
* Length Unit I | in
Value ® 0.39370000

Weight Classes

The length classes are used to assign weight specifications to the products in your
OpenCart store.
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https://www.khanacademy.org/math/cc-fourth-grade-math/cc-4th-measurement-topic/cc-4th-convert-length/e/converting-larger-units-to-smaller-units--millimeters--centimeters--meters--and-kilometers-

e  Marieting

Weight Classes

€& System
| Weight Class List

Welght Title v Weight Unit

Gram [ 4
Kiogram (Defauit) "

OQurce

2052016 Nl Rghes Reserved
21048

Weight Title: The name of the weight unit, for example Kilogram.
Weight Unit: The weight unit, for example KG.

Value: The Default value must be set to 1. Every other length class will be relative to that
value. There are 1000 Grams (G) in 1 Kilogram (KG), so the value of G would be set to 1000.

# Edit Weight Class
* Weight Title + Pound
* Weight Unit i 1]
Value @ 2.20460000
Tools

The Tools section in the Settings contains a tracker for your uploads, a backup / restore
function as well as error logs.

Uploads
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All of your uploads can be filtered by name or date added. Once you find the uploads you
are looking for, you can either download or delete them.

John Doe Uploads - B
ynevrstor
Dashboard . -
I Upload List
p Cotalog
Extensions Upload Name Date Added
-, Design 1N t (-]

Upload Name Fueasme Date Added ~ Action

a1 © 20092016 A Rights Reserved
on 210

Backup & Restore

In case of a database emergency - use this field.

Your store’s database is where all of the important customer and product information is kept.
Re-entering all of the information after it’s lost is a very costly task.

OpenCart lets you download a backup of your store's current database or restore the
database in the Backup & Restore section.

If you need to restore a backup file that you have on your computer, click "Choose File",
select the .sql file from the computer and upload it. The database will be restored.
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Backup & Restore — s
= Backup & Restore

Choose Fie  No fle thaten
Restore Backup

Backup:

Error Logs

The Error log in OpenCart will hold a record of all the errors that have occurred in the code
of the store. Over time, your log might get full, so you can use the clear button to remove the
data.

A recommendation in such cases is to first resolve the errors before clearing them.

These errors are useful for developers who can track issues and fix them.
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Error Log

Dashboard & ‘errorsLise Download / Clear

Cata

Vertion 2101

» o Logs
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Chapter 11: Reports

The last menu in your OpenCart Admin panel is all about tracking data and reports. It
contains valuable information about your orders, sales, products, customers, marketing
campaigns, affiliates and everything in between.

Being a store owner, it will be beneficial for you to spend some time here at least once in a
while to keep track of the combinative data from all the activity in your website.

Let’s start by finding where the menu is and what sub-menus it contains.

Dashboard > Reports

Dashboard

@ World Map M Sales Analytics -

As you see, we have 4 sub-menus. We will start with the first one - Sales.
In the Sales menu, you have reports for Orders, Tax, Shipping, Returns and Coupons. Mind
that these are options that are configured and setup from other menus. Here, you will only

be able to track their performance.

Reports > Sales > Orders
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Dashboard

Orders

TOTAL ORDERS 0%

= 12

@ World Map

£ Recent Activity

Evpend Kolev Croased 3 new o Cer
O 21082016 16323

Evpeni Xolev created 3 new order

6160012

Evpen Xolev Crodsed & new ceger

O 10672016 160048

™ Latest Orders

Order1D  Customer

17 Evpeni Kol

16 Evgeni Kolev

il Sales Analytics 8-
Orders
W <usomen

03

Py AN i
03N 00 10N AT N 2N 7NN
Status Date Added Total Action
Pencng 210672016 $50000 u
Pending 20672006 $500.00 n

..

The orders show you how many orders your store has generated over a defined period of
time in the filter fields.

You can sort the results by Days, Weeks, Months or Years from the Group By field. This will
separate the orders in different rows.

You can also filter order by their status.

The type of information you will be able to track here will be the number of orders and
products that have been confirmed, the tax and total revenue from the row of orders.
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Sales Report . s

M Sales List
Date Start Group By
20050629 8 Years
Date Ind Order Status
USLOMers
Customers 20160718 8 Al Statuses 2
¢ Marketing \.m
System >
M Reports
Date Szart Date End No. Orders No. Products Tax Yoeal
—— A 2110672016 21062016 12 15 $26.00 $6,35300 I

Tax

Each of the orders generated in your store have some tax added to them. The taxes are set
from Catalog > Products > Edit Product > Data > Tax Class.

The tax menu in the reports tracks the types of tax that have been applied to products in the
orders of customers. This includes the number of orders as well as the total accumulated
from the taxes.

John Dos Tax Report
B Dashboard
3 IM TaxList
b Catalog
Extensions
Date Start Group By
Design [ -] Weeks
Sales
Date Ind Order Status
Customers (] AN Szatuses
. m
System
Reports
Date Start Date (nd Yax Title No. Orders Total
210672006 2100672016 £co Tax (-2.00) 1 $4.00
217065016 21062016 VAT (20%) 1 $22.00

Showing 1 t0 2 of 2 () Pages)

Shipping

Shipping costs vary on the shipping methods you have available in your store. You have the
same filtering options for date, sorting and order status.

You will be able to track what shipping method has been used under the Shipping Title tab,
as well as the number of orders and their total.
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Jcta Dos: Shipping Report

Al

® Dashboard

s Shipping List

Date Start Group By
=] Weeks

Date Ind Order Status
o Al Satuses

M Reports
Date Start Date tnd Shipping Title No. Orders Total
s ,
u 20062016 2170672016 Fut Shipping Race 3 $1500 I

showing 120 3 of 1(3 Pages)

Al Rights Reserved
109

Returns

The returns menu is quite simple, as you only have one major metric, which is the number of
returns between a specific period of time you set from the filters.

Once more, you can separate the results in rows according to Days, Weeks, Months or
Years. To narrow down the results even more, use the Returns Status and specify the
statuses you want to see.

Returns Report . saummsen

B Dashboard
e I Returns List

Catalog

Extensions

Date Start Growp By
Design > 20160710 - ] Weeks
Sales
Date Ind Return Status
SLOMEs
Customers 20160718 (-] A Statuses
s  Marketing m
Systern
Reports
Date Start Date End No. Returns
180772016 18072016

Showirg 1o 101 {1 Pages)

DpenCart © 2009-2016 A2 Rghts Reserved
Version 2000
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Coupons

Your coupons are created by going to Extensions > Order Totals. As you see from the
screenshot below, the filtering options for the coupons are limited to dates.

You can see the name of each coupon, the coupon code necessary for customers to enter,
as well as the orders and total generated from using the code.

By clicking the Edit button, you will be redirected to the coupon management field where you
can modify the coupon name, code, type, discount, etc.

john Doe. Coupons Report

ASrrervaty of
® Dashboard
ta Coupon List

b Catalog

Extensions

Date Start Date End
- Design [=] 8
e Sales m
Customers
= Marketing Coupon Name Code Orders Yoeal Action
S‘J-Stcm Wig Discount Coupon N 1 3000

M Reports

> Sales

The next sub-menu of the Reports is all about the products. You have two fields where you
can track which products were viewed and purchased.

Reports > Products > Viewed

Viewed

This is a list of all your products and the views they got from your customers. The list
includes the product name, model, times viewed and percent, which measures how much a
product has been viewed compared to others.

Your most viewed product will be at the top. You can refresh the list with the red button at
the top right corner, so you can update the data at any time.
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Products Viewed RepOrt .. swsvemssess =

Tk M Products Viewed List Times viewed
 Catalog
wodel Viewes

Product Name Percent
Extensions

Phone peoduct 11 9 S41TH

Mt Product 14 19 131%

Aopie Orema 30° 14 8338
Customers NP 193065 2 74%
Marketing Seengung Syncvaster 818w Product 6 12 7.14%
2 MacBook Product 16 9 S36%
System

Canon fO5 50 Product 3 9 ERTAS
Reports

Saensung Galaxy Tab 10.3 SAMY 1 06%

HTC Youch HO Product 1 N 6%

Showing 1 109 of 9 (1 Pages)

Purchased

In the list for purchased products, you have a filter where you can narrow down results
based on date and order status.

You can see all of the products that have been purchased from your OpenCart store
separated by product name, model, how many times the product has been purchased, and
the total revenue accumulated from each product.

Products Purchased Report ... swn-omssessa

I8 Products Purchased List

Date Start Order Status
s M Statuses
Date Ind m
=]
[Number of purchased products] Revenue
System
g Product Name Model Quantity \ Total
M Reports
MatBook Produdt 16 12 $6,000 00

Phone product 1% 3 $335.00

Samisung SyneMaster S41EW roduct 6 ' $200.00

HTC Toueh HD $:00.00

Showing 1 to £ of & () Pages)

Reports > Customers > Customers Online

Now it’s time to see what kind of information you can track about your customers.
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Customers Online

The report for how many customers you have online is based on IP address of the visitor,
which is the last page they viewed, the referrer (the page or website that lead them to the
last viewed page), as well as the last place they clicked.

This type of information is important for knowing the behavior of your users and the potential
improvements you can start making to optimize the customer journey throughout your
OpenCart website.

it Customers Online Report

Dashboard
g W Customers Online List

p  Catalog

Extensions
» Customer

- Design

P Customer Last Page Visited Referer Last Click Action

Customer Activity

The customer activity log lets you track what kind of action each customer has taken at a
particular date and time.

The activities include creating a new order, registering a new account, etc. You will be able
to see the IP address from which the activity has been logged.

You can use the filter to sort customer activity by IP address, customer name as well as
dates.
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Jomnoe; Customer Activity Report

A ¢
Dashboard
22 i Customer Activity List
Date Start Customer
)
Date End »
)
Comment ”» Date Added

Created a new ceder.

180272016 1206201

registeced for an account

Created a new order

Created 3 new orod

Sroated a new ceder

CroOated a new or e

Created 3 new Order

1820772016 17.09:11

Orders

The orders menu under customer reports is quite useful to prioritize users. It lets you view
how many orders each user has confirmed, including the number of purchased products and

total revenue from the customer.

Each customer also has an Edit option that redirects you to the customer management
menu where you can modify any type of information you need about the specific user.

John Do Customer Orders Report

Dashboard
i Customer Orders List

 Catalog

- Extersions

Date Start Order Status
Design (-] Al Seatuses
— (am=
=]
Customer Name EMail Customer Growp Status No. Orders No. Products Total Action
Defauit Enabied 1 1 $175.00
John Do shaPdormain com Defauk frabled 1 1 $105.00
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Reward Points

The reward points are managed from Catalog > Products > Edit Product > Reward Points.
This is where you assign reward points to a given product.

As for the Reward Points menu in the Reports, you can track the reward points used by
each customer, accompanied by information about the customer name, email, customer

group, status, number of orders, and total.

Filtering for the customer reward points can be done by date.

Customer Reward Points Report

Dashboard
ponbs M Customer Reward Points List

 Catalog

Extensions

Date Start Date End
- Design (] 4 [+
iz &=
Customers
¢ Marketing Customer Name Ml Customer Group Status Reward Points No. Orders Total Action
Systemn No results
A Reports Showing 010 0 0 0 [0 Pages)

> Soles

21 © 2009-2016 Al Rgtes Reterved
Verson 2100

Credit

The store credit can be enabled from Extensions > Order Totals > Store Credit.

You can manually assign store credit to customers via the transactions function in
Customers > Customers > Edit Customer > Transactions.

The transactions you modify there will appear in the Credit reports here.
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Customer Credit REpPOrt i  casmecesinsen

i Customer Credit List

Date Start Date End

Customer Name €-ALail Customer Group Seatus Total

System
4 Defaux frabled $834.00

Reports

Next, marketing reports. These menus will include information about how your marketing
campaigns are going as well as the performance of your affiliate program.

Reports > Marketing > Marketing

Marketing

The marketing campaigns in OpenCart are created from Dashboard > Marketing >
Marketing > Add New.

The tracking in your marketing reports will show the campaign name, its unique code, the

number of clicks it has generated and how many orders they have lead to. At the end, you

have total revenue generated from the marketing campaign you have launched.
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John Doe
AGAAL M

Dashboard
» Catalog
- Extensions
Design
Sales
Customers
e  Marketing
System

M Reports

Affiliates

Marketing Report

M Marketing List

Date Start

Date Ind

Order Status

A

Statuses

Campaign Name

Example Campagn

Code

Clicis No. Orders Total

Showrg 100 T of 1{1 Pages)

You can create new affiliates from Dashboard > Marketing > Affiliates. Each affiliate will
have a unique affiliate code. This affiliate tracking code will be used to generate a unique

affiliate link for a specific product, so when a customer purchases the product, the affiliate
receives a commission.

All of this data will appear in the affiliate reports here. You will be able to see the affiliate
name, their email, status, commission, as well as the number of orders and total revenue
generated by their affiliate links.
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John Doe Affiliate Commission Report .. s coms:

% Dashboard

I Affiliate Commission List

Catalog

Extensions

Date Start Date EInd
) &
Affillate Name -Mall Status Commisgion No. Orders Yotal Action
AMRte Jatk cample@examplernad (om Enodied 900 1 $1E5.00
Showirg 1 to 1 of 1 {1 Pages)
OpenCart © 20092016 AT Rights Reserved

Version 2.1.01

Affiliate Activity

The last menu in the reports logs the activity of your affiliates. This tracks when they logged
in, the IP address they used to login as well as the date of the actions.

Affiliate Activity RepOrt .. wesoveseser

L Affiliate Activity List

Date Start AMiliate
-
a
Date Ind w
-
a
Comment "» Date Added
AITWste Jack logted In 1072016 121602

Showing 110 1081 () Pages)

Opendan © 20092016 AN Rghts Reserved
Verson2101

> Afiate Acthity
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This is the last part of the OpenCart Admin panel. You now have information about each

section of the back-end of your E-Commerce store and should be ready to start running your
own business.

The last part of the eBook will let you know how to uninstall your OpenCart store.
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Chapter 12: How to Uninstall OpenCart

To uninstall OpenCart, there are two simple steps you need to take.

First, you delete all of your OpenCart-specific files (be careful if your root directory shares
files with another installation).

Second, you delete your database with all of your product and customer information.

After doing both of these steps, your E-Commerce store will be permanently removed and
the information will be deleted.

Some extra knowledge sources for faster progress:

What Server Do You Need to Run OpenCart

Top 3 Most Popular Marketplaces for OpenCart Themes

OpenCart Communities - A Source of Know-How, Inspiration and Support

7 Of The Best OpenCart Blogs You Don't Want to Miss

8 Best Sources for Elaborate OpenCart Tutorials

Speeding up OpenCart for Free: Image Optimization

Increase Traffic in OpenCart with These 5 Proven Ideas

Starting, Growing and Going Big - The New iSenselLabs Collections
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https://isenselabs.com/posts/opencart-communities-a-source-of-know-how-inspiration-and-support
https://isenselabs.com/posts/7-of-the-best-opencart-blogs-you-dont-want-to-miss
https://isenselabs.com/posts/8-best-opencart-tutorials
https://isenselabs.com/posts/speeding-up-opencart-for-free-image-optimization
https://isenselabs.com/posts/increase-traffic-in-opencart
https://isenselabs.com/posts/starting-growing-and-going-big-the-new-isenselabs-collections

